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Welcome

ZebraDesigner software is a family of labeling software products that offers a complete bar 
code printing solution to label printing users. ZebraDesigner offers an easy-to-use interface 
and meets any label design and printing requirement for efficient label printing solutions to 
users in retail, logistics, health care, chemical, automotive, and other industries.

ZebraDesigner can be used with any of the following 32-bit or 64-bit Windows® operating 
systems: Microsoft® Windows® XP, Windows Vista®, Windows® 7, Windows Server® 
2003, or Windows Server® 2008.

The latest software is available for download on the Zebra web site at 
www.zebra.com/software.

Contents of the package

The latest software is available for download on the Zebra web site at 
www.zebra.com/software.

Before starting the installation of ZebraDesigner software, check the contents of the package 
to ensure it is complete. The package includes:

• ZebraDesigner CD

• Software Activation key, located on label inside of CD case, or delivered via email if 
purchased via www.zebrasoftware.com

If any of the mentioned items are missing, please contact your software vendor immediately 
for package replacement.
13857L-003  11/29/2011
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Overview

The ZebraDesigner Pro User Guide helps you design and print labels quickly.

The User Guide contains the following sections:

Introduction: This chapter will introduce you to ZebraDesigner Pro.

Installation and Activation: This chapter will show you how to install and activate the 
labeling software.

Setting up ZebraDesigner software: This chapter will show you how to set up and customize 
software to your preferences.

Designing Labels: This chapter will show you how to create labels. You should refer to this 
chapter regularly while designing labels, until you have completely familiarized yourself with 
the commands. By using the information contained in this chapter, you will able to use 
labeling software quickly and efficiently.

Printing and Previewing Labels: This chapter will show you how to print and preview 
labels.

Interface Reference: This chapter describes details and explains all the commands used in the 
labeling software.

Technical Support: This chapter provides information on how to contact technical support.

Software Restrictions

All features explained in the document are available in the ZebraDesigner Pro edition; 
however, some features are not available in the ZebraDesigner edition.

Sections discussing features available only in ZebraDesigner Pro will display a note or a "Pro 
Only" icon.

Typographical Conventions

• Text that appears in bold refers to menu names, file names (SETUP.EXE), interface 
buttons (OK), PC keyboard keys (Alt), and menu flows; menu flows have a > that 
separates one menu to the next menu (Start > Programs > Zebra Technologies > 
ZebraDesigner Pro). 

• Text that appears in italic refers to confirming actions, identifies graphic captions, 
identifies text that you need to type, and locations such as Folder.
11/29/2011 13857L-003 
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System and Software Requirements

ZebraDesigner Editions

To run ZebraDesigner, you need at least the following:

• Pentium-based computer with at least 64 MB of RAM.

• One of these 32-bit or 64-bit Windows operating systems: Windows XP, Windows Vista, 
Windows Server 2003, Windows 7, and Windows Server 2008.

• Hard disk with 100 MB of free disk space.

• CD-ROM drive.

• Support for OLE DB database drivers. Recent Windows operating systems have included 
OLE DB database drivers. If your operating system does not have the database support, 
the installation wizard prompts you to install it.

• Administrator rights to the local computer during installation.

Installing ZebraDesigner Pro

Overview

When you put the ZebraDesigner Pro CD in your CD-ROM drive, typically the 
installation/demonstration program automatically starts. You can browse the directory of the 
CD and look at the brochures, technical documentation, sample files, and other documents.
Note • You must be logged on with Administrator rights to the local computer to perform the 
installation.

Close All Software Applications

To ensure complete installation of ZebraDesigner Pro, close all open software applications 
before you start installing ZebraDesigner Pro.

Run Installation

Use the installation wizard to install ZebraDesigner Pro on your computer. 

To install the software, do the following:

1. Put the ZebraDesigner CD in your CD-ROM drive. An installation window automatically 
opens.

Note • If the installation wizard does not start automatically, go to the main CD directory 
of your ZebraDesigner CD and double-click the file START.EXE.

2. Select the language in which you wish to use the software.

3. Click OK. A new window opens showing the ZebraDesigner Pro installer.
13857L-003  11/29/2011
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4. Click Next and confirm the License Agreement.

5. Follow the prompts of the Installation Wizard and enter the relevant information.

Note • For ZebraDesigner Pro, you may be prompted to activate the product when you run 
it for the first time.

Define Setup Options

To continue installation, do the following:

1. Click the Next button.

2. Specify the program group you want to use for ZebraDesigner Pro.

3. Specify if shortcuts to ZebraDesigner Pro should be created on the desktop or in the Quick 
Launch bar.

4. To finish installation, click the Install button.

After installation you will be asked to install a printer driver. It is necessary to install a 
ZebraDesigner driver. If you do not install a Zebra printer driver after installing 
ZebraDesigner, you will be prompted to install one the first time you run the program.

5. Once the installation is complete, the Start menu in Windows shows a new program group 
for Zebra Technologies that contains shortcuts for all ZebraDesigner Pro applications.

Install Printer Driver from within the ZebraDesigner Environment

To install the ZebraDesigner printer driver on your computer, do the following:

1. In ZebraDesigner environment, open the File Menu and click on Install Printer.

2. The printer installation wizard starts.

3. Follow the onscreen instructions.

The driver not only allows you to use all supported Zebra printers with the ZebraDesigner 
software, but also provides a handy way of sending settings and commands straight to the 
printer through the driver.
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Activate ZebraDesigner Pro

Activate ZebraDesigner Pro to obtain all features. If you do not complete the activation 
process, ZebraDesigner Pro only runs in DEMO mode.
Note • ZebraDesigner does not require activation. It is free software, but available with less 
functionality than ZebraDesigner Pro.

To activate the software, do the following:

1. Start ZebraDesigner Pro.
The Warning dialog box appears.

2. Click the Activate button.

3. Enter the key number.

Demo Mode

ZebraDesigner Pro running in the DEMO mode has limited functionality. The major 
limitations of the ZebraDesigner Pro DEMO mode are:

• All e characters in the text objects are replaced by Z characters.

• Graphic images are printed with DEMO text written over them

You should use the DEMO version only to evaluate the software. 

Any commercial use of the DEMO software is prohibited. To obtain the full working version 
of ZebraDesigner Pro, you must purchase and register the software.
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User Interface

Start the software by clicking on the desktop icon or selecting it from the Start menu: Start > 
Programs > Zebra Technologies > ZebraDesigner Pro 2 > ZebraDesigner Pro 2

This is the ZebraDesigner Pro main window, with a blank label design displayed.

Figure 1 • Main Window
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Using the Keyboard and Mouse Effectively

When selecting objects, use the Ctrl key to adjust object’s anchoring point by clicking the 
object placeholders.

If you have a Wheel Mouse, you can use the wheel to scroll the label up and down. Holding 
Ctrl when rotating the wheel adjusts zoom factor, and Shift scrolls the label left or right.

Double-click on the printer’s name in status bar at the bottom of the screen to open printer 
properties dialog box in which you can set various options for the currently selected printer.

You can quickly move objects from one open label to another by dragging the desired object to 
another window while holding Alt. If you want to copy objects instead, hold both Alt and Ctrl. 
Note that you must have both label windows visible to do that.

You can select different objects on a label using the Tab and Shift +Tab keys.

Pressing the cursor keys while holding the Ctrl key can move the selected object. You can use 
this to fine-tune the position of the object. Holding Shift while pressing cursor keys will resize 
the object.

You can use the right mouse button almost anywhere on the label to access the most common 
options for that area/object. For example, if you click an object with the right mouse button, a 
pop-up menu appears that contains options and actions that can be performed on the selected 
object. Similarly clicking other parts of the label produces pop-up menus with options for that 
part of the label.

You can select multiple objects by holding Shift while clicking them.

Use the element shortcuts in toolbars whenever possible. Each label element that can be 
connected to some Contents Provider has a shortcut enabled to quickly access existing 
variables or define new ones. Click the element’s shortcut handle, shown as a small arrow by 
the side of some toolbox icons.
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Interface Reference

Mouse Wheel support

If you have a mouse that has a wheel in place of the middle button, you can use it to speed up 
zooming and scrolling:

• Turning the wheel scrolls the label up or down.

• Holding Shift and turning the wheel scrolls the label left or right.

• Holding Ctrl and turning the wheel zooms the label in or out.

Shortcuts

Delete Deletes selected object

Ctrl + X Cut

Ctrl + C Copy

Ctrl + V Paste

Alt + Backspace Undo

+ (on numeric pad) Zoom In

- (on numeric pad) Zoom Out

Alt + Shift + 
Backspace

Redo

Ctrl + T Rotate 90°

Ctrl + A Align

Ctrl + Z Undo

Ctrl + Y Redo

Ctrl + N New

Ctrl + O Open

Ctrl + S Save

Ctrl + P Print

Ctrl + R Print preview

Ctrl + move the 
object with mouse

Parallel moving of the object by main axes only

Alt + move the object 
with mouse

Objects snap to grid even if it is off
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File Menu

New Label

To create a new label and clear the application work area, select New command from File 

menu. Clicking the  button has the same effect.

The software supports opening multiple documents and they are named with the increasing 
numbers: Label1, Label2... unless you save them to different filename.

The Label Setup Wizard dialog box will appear on your screen. Label Setup Wizard offers 
defining dimensions of the label and changing printer setup.

Open

This command opens an existing label. You can also click the  button in the standard 
toolbar.

The default label folder is My Labels in My Documents. This folder also includes shortcuts to 
other folders with sample labels. When you need to open a label file, which has been saved in 
a different folder or drive, you can use the Windows browse function to access it.

Once you have found the appropriate label, you can open it by double clicking its name, or by 
clicking the Open button.

Close

This command closes the active document. If you have made changes in the document and 
have not saved them, the program will prompt you to save the label.

(If the document has not been named yet, the software will also prompt you for the name and 
the Save As command will be executed).

Ctrl + move the 
object with cursor 
keys

Fine tuning the position of the object

Shift + cursor keys Fine tuning the dimensions of the object, resize width and height 
in very small steps

Right-clicking the 
object

Opens pop-up menu with shortcuts to commands. The content of 
the pop-up menu depends on where you clicked your mouse 
button and what was selected at that time

Enter F2 or
double-click

Opens properties dialog box of the selected element
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Save

This command saves the active document in the current label file. If no file name has been 
defined yet, you will enter the Save As dialog box.

The Save command can also be accessed directly by click the button. 

Save As

Select this command when you want to name a new label or when you want to copy an 
existing label under the new name or to another folder or drive.

The default folder to save the labels is My Label in My Documents. When you need to save the 
label to a different folder or drive, you can use Windows browse function to define the target 
folder.

Export to Printer

Export the label to the printer so it is available for stand-alone printing.

Label Setup

Should you want to change the label parameters, such as dimensions or print orientation, use 
the Label setup command from the File menu or double click the label. The Label Setup 
Wizard dialog is shown.

Install Printer

Select this command when you want to run the printer installation wizard. After completing 
the wizard, the printer becomes available, and ZebraDesigner does not need to be restarted.

Remove Printer

Select this command when you want to remove one of your installed printers. 

The printers that are currently used by the application are shown as disabled and cannot be 
removed. The removal of the printer does not require a restart of the application.

Printer Settings

Specific printer settings are set here. The shortcut to this dialog is to double click the printer 
name in a status bar in the bottom of the working window.

Note that all printer settings are saved with the label and are restored every time the label is 
opened. Each label will store its own custom printer settings. In case you want to print the 
label with a different printer, the other printer will have to be setup again to suit your needs. 
When changing the printer associated with the label, every custom setting is lost and have to 
be re-configured.

When you change the printer associated with the label or when you create a new label, the 
default printer settings are used. These default settings can be set for each printer in Control 
Panel.
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Print and Print Preview Menu

Print and Print Preview

From the File menu, use the Print and Print Preview commands to print the labels on your 
printer and to simulate the production of the labels onscreen. Previewing the label allows you 
to check that all objects are positioned correctly without spending time and wasting labels.

In the Standard Toolbar, you can click the  button.

When you set values to variables and select records from the database, click on the appropriate 
button in the bottom of the dialog box. The Preview button will preview labels onscreen. The 
Print button will print labels to the selected printed.

If you are previewing labels, a control window will open to preview the next labels in a series.

Figure 2 • Print pause dialog box

Next: Go to the next label in a series.

Previous: Go to the previous label in the series.

Delay: Labels will be previewed automatically. Next label will be displayed after a short time 
delay. Click on the Stop button to disable automatic advance.

Cancel: Click this button to stop previewing labels.

Print: Click on this button to print the labels.

Print Dialog Box

The Print dialog box is shown when you want to print or preview the labels. This dialog box 
allows you to:

• Provide values for the variables.

• Select records from the database.

• Specify label quantity.
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Figure 3 • Print dialog box

General: Use this dialog to enter the values for prompted variables.

The entries are displayed in the table. The first column displays the prompt text of the variable. 
You can enter the values for variables in the second column. The third column will display the 
formatted values (based on the variable format).

Select records: This dialog displays when a database is being used. Click on this button to 
select the records from the database. A separate Record Selection dialog box will open.
Note • The button Select Record is accessible only if the records selection is enabled in the 
database properties.

Quantity: Select the quantity of labels to be printed.

Print to file: When this checkbox is selected, the software package will offer the user the ability 
to write the command language out to a file.

Close after print: The print dialog will be closed after the print button has been clicked.

Clear values after print: When selected, this option will clear the last entered values for the 
variable fields. If not selected, the last entered values could be re-used in the prompt field and 
the label is ready to be printed again with the old values.

Click the Print button to start printing (or Preview for preview).

To close the dialog box, click the Close button.
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Record Selection

The Record Selection dialog box is available only if you have a database linked to your label 
and have specified that you want to select records from the database.

The purpose of the Record Selection dialog box is to be able to instruct the application not to 
print all records from the database, but only the records that you will select.

Figure 4 • Record Selection dialog box

If you do not know the exact location of the record in the database you want to 
print, you can use the search functionality. Enter the phrase you would like to find, 
select the field name where the text should be searched for, and click the Find 
button.

Exact Search: Only the records that match exactly the entered condition will be 
displayed. The record has to contain only the data entered and it has to be in the 
proper case.

Select All: This button will select all records in the database. 

Unselect: This button will de-select all marked records in the database.
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You can select the multiple records using standard Windows shortcut with Ctrl key. Press and 
hold the Ctrl key, use the mouse to select records one after another, or you can check each 
selected record in the beginning of the line. Put a check mark in the checkbox. Only the 
records that have a check in the checkbox will be printed. Use Space key to toggle the 
selection/de-selection of marked records.

If you have set up your database connection to enter the quantity of labels you need to print for 
each record, additional field will be inserted in front of the first field. It is marked with pound 
(#). Use this field to define the quantity for each record you need to print.

Optimize for fast windows load: Enable this option to speed up the display of table data when 
you enter the dialog box the next time. The check boxes for selection of record will not be 
displayed, which speeds up working with larger databases. Record selection in this mode can 
be performed using standard Windows shortcuts with Shift and Ctrl keys.

If you want to easier navigate through larger databases there is an option for you to group the 
records by some database field. You can nest fields one below the other and create a tree 
structure for more complex field grouping. Just click and drag the field name to the spot above 
the table.

Besides grouping, you can also benefit from filtering functionality. Filtering can be very useful 
in situations where you are dealing with larger tables and would like to limit the view of the 
table data. You can set a user-defined conditions to the table and only record that comply to 
them are displayed. 

To enable filter on some field, click the arrow button next to the field’s name. There are 
multiple options you can select:

Filters can be combined on more than just one field.

If the field has a filter defined, the arrow next to field name in the caption will be displayed in 
blue color. If the filter is not defined, the arrow is displayed in black color.

All Select this to disable filter on this field.

Custom Create a custom filter for this field. You can select standard qualifiers 
as: equals, does not equal, is less than, is less than or equal to, is greater 
than, is greater than or equal, like, not like, is blank, is not blank.

You can nest two conditions for the filter and thus build a more 
complex condition for the field. They can be joined together using 
AND (all conditions must be true in order to display the record) or OR 
(only one condition must be true in order to display the record) logical 
qualifiers.

A separate dialog box is used for defining the custom filter.

Blanks Only the records with blank values for this field are shown.

Non Blanks Only the records with non blank values for this field are shown.

<data values> Only the records that have the selected data value in this field will be 
shown.
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The list of defined filters is also visible below the table. You can remove the filter(s) by 
clicking the  button or temporary disable the filter by ticking the  button next to the filter 
definition.

If you want to make more modifications to the filter(s) used on the table, click the Customize 
button to open a separate dialog box with detailed control over filters. If you prefer to have 
more structural overview on the filters, you will like this option. This way you can quickly 
define more conditions and groups using one dialog box.

You can save the filter for the future use (Save As button), and you can load a filter you have 
created previously (Load button).

Test Print

The Test print command will print the current label to the printer defined on the label. All 
variable fields on the label are automatically filled with the default values.

Only one label will be printed. The purpose of this command is to quickly print the label, in 
order to verify that the label objects are positioned and aligned on the label correctly.

Recently Used Files

At the bottom of the pull down menu, the file names of the four most recently edited labels are 
shown, available for quick selection.

Selecting the file here is the same as choosing the Open command from the File menu and 
selecting the file there.

Exit

Use this command to leave the labeling application. When using the keyboard, the shortcut to 
this command can be invoked by pressing the Alt and F4 keys simultaneously. If the opened 
labels haven’t been saved yet, you will be prompted to do so.

Edit Menu

Undo

The Undo command cancels up to 10 of the most recently carried out commands or actions. If 
you do not like the results of a command, or accidentally delete some elements, choose the 
Undo command as the next action to restore the previous mistake.

The Undo command can also be activated by clicking the  button on the toolbar, or 
pressing the Alt and Backspace key simultaneously.

Redo

The Redo command is used when you need to restore the last Undo action. It also has the 
capability to store (and restore) up to 10 previously made steps.

The Redo command can be activated by clicking the  button on the toolbar, or pressing 
Shift, Alt, and Backspace keys simultaneously.
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Cut

This command is used when you want to remove selected element(s) from the label. Note that 
the first element is selected by clicking it. When you want to select additional elements, you 
must press and hold down, the Shift key while clicking each additional element.

The cut elements are stored in the internal clipboard and can be re-inserted on the label with 
the Paste command. The combination of Cut and Paste commands can be used to speed-up 
label editing and designing.

The Cut command can be also activated by clicking the  button on the toolbar, or by 
pressing the Shift and Del keys or Ctrl and X keys simultaneously.

Copy

This command copies the selected elements to the Windows clipboard.

Clicking the  button or pressing Ctrl and Ins keys or Ctrl and C keys simultaneously can 
also activate the Copy command.

Paste

The Paste command is used to paste the contents of the clipboard to a label. This command 
can be used to paste the same information more than once.

It is very useful when you need to have multiple copies of the same element on the label.

Once the element has been designed, it can be copied to the clipboard and pasted on to the 
label, in different places and multiple times.

You can also design objects in other Windows applications, copy them to the clipboard, and 
place them on the label with the Paste command.

Clicking the  button or pressing the Shift and Ins keys or Ctrl and V keys simultaneously 
can also activate the Paste command.

Paste Special

This command provides different ways to paste the contents of the clipboard.

The Result box explains the appearance of the clipboard contents on the label.

For example, you can paste the text from the clipboard, produced by Microsoft® Word as a 
Word document, or as a Metafile Picture. When pasted as a Word document, the object can be 
edited by double clicking it. Instead of icons and menus of a labeling application you will see 
Word working space. You can use familiar Word user interface to make a changes. When 
finished, labeling interface will be restored.

When the object is pasted as a Metafile Picture, it is treated as a graphics.

In the dialog box you can choose between two different types of paste. The first one (Paste) 
makes the copy of the original, the second one (Paste Link) links the original document with 
the label.
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Paste Link

Using the Paste link command establishes a link between labeling application and the source 
application for the contents of the clipboard.

The link information is saved in the source file; only the location of the information in the 
source file is saved. The link data shows in the graphic form.

Double clicking a Paste-link object will place you into the original source Windows 
application for that object. The object is then edited in the application.

Delete

The command is used to delete selected elements. Deleted elements are not stored in the 
clipboard. To restore deleted elements, the Undo command must be used before any further 
actions. Delete command can also be activated using the Del key.

Select

This command allows you to select different objects on the label.

You can select all objects on the label, or selectively mark only objects from the same group 
(i.e., all text objects, all bar code objects, all picture objects, etc).

Insert Object Menu

Insert Object

This command inserts an OLE object on the label. Two subcommands exist, to import the 
document from the existing file on the disk or to create a new document from scratch.

Avoid using inserted objects on the label. This consumes a lot of memory because the server 
application must be running too. The file size of the label will also increase. These are other 
solutions to consider:

• Convert your objects to picture and place such picture on the label.

Note • Resizing an OLE object may not work as you expect. It is advisable to resize the 
object only when in OLE edit mode (after double clicking the object).

Create from File

With this command you can insert to labels already defined objects. If the object is in a Word 
file, you just select the directory and the name of the file.

Create New

With this command you can insert in a label objects from any Windows application that 
supports OLE 2 interface.
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Links

On the screen this command shows a list of all links between the active label and other 
applications in your working environment. When you insert an object on the label with the 
Paste Link command, you will see this link in the list.

The links can be interrupted. This means that the changes made in the source document will 
not be made on the label.

Show Objects

The command shows all inserted objects:

• If the object is linked, the object is marked with a dotted line.

• If the object is inserted, the object is marked with a solid line.

The purpose of this command is to separate objects created on the label from those linked to 
other applications.

View Menu

Normal View

Selects normal label view.

In this view type, variables are shown on screen as a series of question marks (?). The number 
of question marks corresponds to the variable length. Use this view to precisely position the 
elements on the label as you know their maximal possible length.

Data View

Selects the data label view.

The variable elements are shown as they will appear when printed. For example, counters will 
show numbers and database variables will show data that is obtained from database.

When using data view printing starts at the record currently shown on the screen and not at the 
beginning of the database. Be careful when printing records from a database. If you want to 
print labels from the first record, make sure the first record is shown on the label.
Note • Databases are locked if you are using data view and variables from these databases. An 
already opened database cannot be simultaneously used in another program. You cannot 
change the structure of the database and alter its records, if using data view.

Zoom In

Zoom in command shows a smaller section of the label. The + (Plus) key on the numeric 
keypad can also be used. Each time Zoom in is selected and you click once on the label, the 
displayed picture becomes 10% larger.
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Zoom Out

Zoom out command shows a wider view of the label. The - (Minus) key on the numeric 
keypad can also be used. Each time Zoom out is selected, the displayed picture becomes 10% 
smaller.

Zoom

When using the Zoom command, you can define the optional zoom factor you need. You can 
choose any zoom factor from 5 to 3000. 

Figure 5 • Zoom dialog box

In the Zoom dialog box you can select the different ways of zoom.

Snap to Grid

Selecting this option enables the positioning of the objects to be based on the grid settings. 
When you move the objects, they are placed on a grid position. De-selecting this option allows 
elements to be freely moved on the label. 

The upper left corner of the object is used for starting point of the grid.

Grid size cannot be modified.

Display Grid

Selecting this option makes the grid visible on the label. De-selecting the option hides the grid.

Factor You can define your own factor of zoom (in %).

100% The size of the document on screen will be the same as the size of the 
document on the label.

To page You will see the entire page on the screen.

To label You will see the entire label on the screen.

To objects You will see all the objects on the screen.
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Toolbars

Standard Toolbar

Buttons in the standard toolbar provide shortcuts to frequently used commands for working 
with the software.

Design Toolbar

The design toolbar provides you with the shortcuts to the frequently used design actions on the 
label.

By default, the design toolbar is docked on the right side of ZebraDesigner window.

You can use the design toolbar to:

• Change the color of label objects.

• Align the objects relatively to each other or to the label.

• Rotate the objects.

• Change the order of the objects.

Text Toolbar

Shortcuts in the text toolbar enable you to format text objects with a single mouse click. You 
can change font selection and style.

Toolbox

Select

Use this tool to enable the select tool.

Text

Use this tool to define the text object.

Click on the small arrow button for additional options.

Bar code

Use this tool to define the bar code object.

Click on the small arrow button for additional options.
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Picture

Use this tool to define the picture object.

Rectangle

Use this tool to define the rectangle object.

Line

Use this tool to define the line object.

Ellipse

Use this tool to define the ellipse or circle object.

Inverse

Use this tool to define the inverse object.

Object Menu

Select

After you select the Select command in the Object menu or click the  button 
in the Toolbox, the arrow cursor appears.

Use this command to select objects on the label.

Text

After you select the Text command in the Object menu or click the  button 
in the Toolbox, the cursor with the bar text appears.

Use this command to place text objects on the label.

Bar Code

After you select the Bar Code command in the Object menu or click the  
button in the Toolbox, the cursor with the bar code symbol appears.

Move the mouse cursor to the desired position of the label and click to enter the Bar code 
Wizard dialog box.

Picture

After you select the Picture command in the Object menu or click the  
button in the Toolbox, the cursor with the picture symbol appears.

Select this command to place a picture on the label.
11/29/2011 13857L-003 



Setting Up ZebraDesigner Software
User Interface

32
Rectangle

After selecting the Rectangle command in the Object menu or clicking the 

 button in the Toolbox, the cursor with the rectangle symbol 

appears.

Thickness: Defines the width of the object borders.
Note • The valid values for thickness depend on the printer being used on the label. Not all 
values are acceptable for all printers.

Print as Graphics: This option lets you print the object as an internal printer element, or as 
graphic elements.
Note • Printing will be faster if you do not check this option. However, if you have selected 
some line or fill style options that your printer does not natively support, the printing will be 
auto-set to Print as Graphics and you will not be able to disable it.

Rounded Rectangle: With this option you can define rounded corners of the rectangle. You 
can select thickness and radius for the object.

Line

After you select the Line command in the Object menu or click the 
button in the Toolbox, the cursor with the line symbol appears.

Use this command to draw lines on the label.

Ellipse

After you select the Ellipse command in the Object menu or click the 

button in the Toolbox, the cursor with the ellipse symbol appears.

Thickness: Defines the width of the object borders.
Note • The valid values for thickness depend on the printer being used on the label. Not all 
values are acceptable for all printers.

Print as Graphics: The option lets you print the object as an internal printer element, or as 
graphics element.
Note • Printing will be faster if you do not tick this option. However if you have selected some 
line or fill style options that your printer does not natively support, the printing will be auto-set 
to Print as Graphics and you will not be able to disable it.

Inverse

After you select the Inverse command in the Object menu or click the  
button in the Toolbox, the cursor with the inverse symbol appears.

Adds an inverted box to the label. The inverted box turns inverses the color of all underlying 
objects.
Note • The Inverse command is not available for all printers. If the printer does not support 
Inverse functionally internally, the command cannot be selected.
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RFID tag

The button is used to enable programming of RFID tags embedded into the labels.

Database Menu

Database Menu

ZebraDesigner Pro allows you to use databases, in which your data is stored. Database types 
can be:

• ASCII (text file) where fields are fixed-length or are separated with the delimiter.

• Microsoft Excel database.

• Microsoft Access database.

• Existing ODBC data sources.

Create Database Connection: This command starts the database wizard that will help you 
link the database to the label.
Note • If the database is already linked on the label, you will be able to change its settings.

Delete Database: This command removes the database from the label.
Note • The database fields must not be used on the label, if you want to delete the database 
link from the label.

Tools Menu

User Interface

Toolbox

Bar codes

Display toolbar with bar codes for easier access to the available bar code types.

Captions

Display captions next to the icons in the Toolbox.

Large Icons

Use large icons in the toolbars.

Small Icons

Use small icons in the toolbars.

Menus Show Recently Used Commands First

Enable this option to show only recently used commands in the menus.
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All other commands are hidden to minimize the length of the menus.

Printer Tools

Printer Tools allow you to send specific commands directly to the printer. These commands are 
simply pre-programmed strings of commands that you would be able to enter in the Direct 
Communication interface. The Printer Tools interface provides a user-friendly tool which 
allows the sending common commands to the printer, without the need for the printer to 
provide a reply to the user. The commands are divided into the following two categories:

• Print – includes commands which trigger printing

• Action – includes commands which alter a setting in the printer and do not trigger printing

Language

Figure 6 • Language dialog box

You can change the language used in the application with this option. For changes to take 
effect application must be restarted.

Store pictures into label

This option allows you to store the images used in the label into the label file. This enables you 
to transfer the label to a different computer by simply transferring the label file. If this option is 
not selected, images are lost when the label file is transferred to a different computer.
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Font Downloader

This command starts the Zebra Font Downloader, which is used to download fonts to the 
printer’s internal memory. Downloaded fonts perform in the same way as internal printer 
fonts, optimizing printing by reducing the amount of needed communication sent to the 
printer.

It is also possible to access the Zebra Font Downloader by clicking the Start Menu > Programs 
> Zebra Technologies > Zebra Font Downloader > Zebra Font Downloader

If this option is not available in ZebraDesigner, Zebra Font Downloader is not installed. The 
installation of the Zebra Font Downloader is available with the installation of printer drivers.

Window Menu

Cascade

Use this command to cascade all open windows.
Note • Make sure all the windows you want to display are open. Minimized windows cannot 
be displayed.

Tile

Use this command to tile all open windows in working space.
Note • Make sure all the windows you want to display are open. Minimized windows cannot 
be displayed.

Arrange Icons

Use this command to arrange icons (minimized windows) in working space - to the bottom of 
it. This has effect only if icons are not already arranged.

Close All

This command closes all open windows (documents) with prompting for all unsaved 
documents. Use it to quickly close all windows with one command (otherwise you have to use 
Close command in File menu for each window).

Window List

When one or more windows (documents) are open, they are all listed. You can quickly switch 
between windows by selecting an appropriate one. If more than nine windows are opened, 
more are accessible by choosing option More windows…
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Help Menu

Content

This command opens the content file for this help.

About

This command displays the application version information and name of the user that has 
installed and registered the application.

System Folder

The labeling application uses its system folder for storing files needed to run the program. The 
location of the folder varies depending on the Windows operating system used.

The default location is C:\Documents and Settings\All Users\Application Data\Zebra 
Technologies\ZebraDesigner Pro. This location may be modified by the user during 
installation.

It is important to own the write access to this folder on your computer system and the right to 
write to and modify files in this folder.

In these files, user data and user rights are stored, as well as custom settings, variable trace 
logs, label usage logs, variable definition files *.LVR, bar code standards, and file names 
GLOBALS.TDB. It also stores the values of global variables.

You should design the appropriate folder layout on disk for your label projects. You can 
increase your work efficiency if you always know where certain types of files are stored. The 
application also finds required elements faster this way. This is important with more 
demanding labels, which intensively use databases, pictures, and forms. Make a separate 
folder for each project you are building, e.g. Project1. Beneath this folder make subfolders 
Database (for databases), Forms (for forms) and Labels (for labels). Store appropriate files in 
each of these subfolders.

Welcome Wizard

When you start the labeling software, a Welcome Wizard will appear. It provides a quick 
access to most-used commands when starting working on a label layout.

Create a new label A blank label will appear and Label Setup Wizard will start. 
You can then design a new label from scratch.

Open recently used label A list of recently used labels will appear to provide a quick 
access to commonly used labels.

Open other existing label A common Windows dialog box opens to let you browse for 
the appropriate label file.
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Overview

With the Label Setup Wizard you can define the dimensions of the label and change printer 
setup. It consists of a few simple steps. 

Select a Printer

Figure 7 • Label Setup Wizard - Selecting printer

If you want to set the printer parameters, select the desired printer, and click the Properties 
button. The printer properties dialog box appears, allowing you to set the printer parameters 
such as print speed, print darkness, and print direction. 
Note • This is a standard Windows printer properties dialog box and its options may differ 
from printer to printer because it is based on the printer driver.

To continue, click Next.
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Figure 8 • Label Setup Wizard - Print Mode

Standard Print Mode

This is the usual print mode, where the printer sends all of the information to the printer and 
prints it immediately.

Store label template and recall it for printing

This setting allows the user to store the fixed data on the label to the printer’s internal memory 
and only send the variable information to the printer during the print operation. The variable 
data is merged with the stored fixed data by the printer. This results in faster printing of 
repetitive labels due to less data being sent between ZebraDesigner and the printer.

Store and Recall is operated in the Print dialog window, where the Store Label Template tab is 
used to execute the storage operation. Any regular print command on such a label is a Recall 
operation.

Select one of the print modes and click Finish to complete the Label Setup Wizard.
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Select the Label Stock

Figure 9 • Label Setup Wizard - selecting label stock

If you use one of the standard predefined label formats, you can specify it here.

Stock Type: Select the type of stock.

Stock name: Select the stock from the list.

Stock information: The information about label dimensions, printer settings, and background 
images as defined by the selected stock.

Label linked to stock: If you enable this option, you cannot change the dimensions of the label, 
because the stocks locks the dimensions.
Note • Using pre-defined stocks simplifies the process of label creation because you do not 
have to define the label dimensions manually.

To continue, click the Next button.
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Define the Page Size

Figure 10 • Label Setup Wizard - choosing Label Dimensions

Select the page size for your labels.

Automatically set from label dimension: ZebraDesigner printer drivers will automatically size 
the label dimensions.

Select page size: You can also manually define the page size.

To continue, click Next.
13857L-003  11/29/2011



43Designing Labels
Using Label Setup Wizard
Select the Label Orientation

Figure 11 • Selecting label layout

Orientation: Select the label orientation. Look at the screen and printer layouts to see how the 
label will be printed from the printer.

Print directions: Click the Rotated option to rotate the label 180 degrees, when printed.

To continue, click the Next button.
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Define the Label Dimensions

Enter the label dimensions in this dialog box.
Note • If you selected the label stock in the previous step, the values for dimensions are 
entered automatically.

Figure 12 • Label Setup Wizard - defining the label format

Width, height: Define the label dimensions.

Margins: Define the label margins.

Rows, columns: Define the number of labels in horizontal and vertical directions. This option 
is commonly used with office printers.

Gaps: Define the gap between the labels.
Note • Define gaps only if you changed the rows and columns options. If you have rolls of 
labels, the gaps between the labels are auto-identified by the gap sensor in the printer.

Unit of measure: Change the unit of measure you want to use.

When you are satisfied with the label dimensions, click the Finish button to close the Label 
setup wizard.
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Overview

In this section you will learn how to design a simple label file with fixed and variable objects. 
The variable objects get values from several sources. You will learn how to:

• Provide object values with a keyboard prompt.

• Obtain object values from a database. 

• Preview the label on the screen.

• Print the label.

The label you create will look like this:

Figure 13 • Basic label
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Create a Basic Label

Create a New Label

To create a basic label, do the following:

1. Open ZebraDesigner Pro or ZebraDesigner.

2. From the File menu, select New or click the  button in the Standard Toolbar.

Each time you create a new label, a Label Setup Wizard will start to help you set up the label 
and connect to the printer.
Note • You can leave the Wizard at any time and accept the default settings for the label by 
clicking the Finish button.

Select a Printer

1. Select the printer you want to use for label printing.

Note • If you don’t find your printer on the list, see Install Printer Driver from within the 
ZebraDesigner Environment for installation instructions.

Figure 14 • Selecting a printer

2. Click the Next button. 
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Define Label and Page Dimensions

1. If you want to use the label stock, select your choices in the Select Stock window. 

Figure 15 • Selecting stock
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2. Click the Next button. 

A new window opens to define the label dimensions manually.

Figure 16 • Selecting page size

3. Leave the Page Size option at Automatically set from label dimensions (default) and 
check Automatic Sizing. 

4. Click the Next button. 

A new window opens
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5. Select the label orientation and print direction.

Figure 17 • Selecting the label layout

6. Click the Next button. 

A new window opens.
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7. Enter the label width and height.

Figure 18 • Defining label dimensions

Note • To change the unit of measure from centimeters to inches or other supported units, 
click on the button with unit of measure below the label preview in the dialog box.

8. Click the Finish button. A new empty label with the settings you selected is created.

Enter Fixed Text

9. Click the  button in the Toolbox. The text cursor appears on the screen.

Figure 19 • Cursor for text object

10. Move the cursor to the location on the label where you want to place the text object and 
click the mouse button.
The Text Wizard dialog box with object properties opens.
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11. Type SAMPLE and click the Finish button.

Figure 20 • Entering content for text object

12. Click on the text object to select the object.

13. Using the Text Toolbar, change the font for the text object.
Choose Arial font, 28 point size, and bold style.

Using format options in the text toolbox:

14. To change the position and size of the text object, select the text object and drag the object 
with your mouse to the desired position.
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The screen should show the following:

Figure 21 • The text object is placed on the label

Object Positioning Guidelines

Guidelines are available to assist you in positioning objects on the label. The functionality of 
guidelines is similar to grid, but they allow you much more freedom regarding positioning, 
moving, and combining positioning delimiters.

Although the guidelines may be visible while designing the label, they will not be printed on 
the final product, regardless of whether the Display Guidelines setting is turned on or off.

Create Guidelines

Create vertical and horizontal guidelines:

• Click anywhere in the ruler area and drag the line out of it (the top ruler contains 
horizontal, and the side ruler contains vertical guidelines).

• Finally, you can open the View menu and access the commands there.

Using Guidelines

The guidelines may be moved at any time with the drag of a mouse. If they are dragged back to 
the ruler area, they are deleted. It is possible to toggle between displaying and hiding the 
guidelines, either by using the menu or right clicking them. 

The guidelines can be hidden with the Ctrl+H shortcut key combination, and when they are 
hidden, the Snap to Guideline functionality is also disabled. The menu also includes a Remove 
all Guidelines command, which removes all the guidelines on the label.

Holding down the SHIFT key while dragging objects allows you to temporarily turn on the 
Snap to Guidelines function.

Guideline Properties

Double-click a guideline or right click a guideline and choose Edit Guideline Properties to 
open the Guideline Properties dialog window. The dialog allows you to enter the numeric 
positioning value, choose the horizontal or vertical guideline type, or remove the individual 
guideline.
Note • This functionality is only available in ZebraDesigner Pro
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Insert Bar Codes

Now you will add a non-changeable Code128 bar code on the label.

1. To insert the bar code, click the  button in the Toolbox.

2. Move the cursor to the desired position on the label and click the mouse button. The 
Barcode Wizard dialog box with object properties will open.

3. Enter the value 1234567890 for the bar code contents.

4. Click the Define button. Edit Bar Code dialog box opens.

5. Make sure you select bar code Code128 and click the OK button.

Figure 22 • Selecting bar code type

6. To return to the label, click the OK button.

7. Change the position of the bar code by selecting the bar code and dragging it to the desired 
position.

8. Change the object size by dragging the object handles. The handles are small rectangles 
surrounding the object when it is selected.
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The label should now show the following:

Figure 23 • Label with text and bar code objects

Insert Pictures

The ZebraDesigner Pro works with BMP, PCX, GIF, WMF, JPEG and many other popular 
graphic formats.

1. To insert the picture, click on the  button in the Toolbox.

2. Move the cursor to the desired position on the label and click the mouse button.

3. The Open dialog box will open allowing you to browse for a picture on your hard drive. 
Go to the folder Samples >Graphics and select the picture LEISURE.WMF. 

4. Click the Open button.

The screen should show the following:

Figure 24 • Label with text, bar code, and picture objects
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Save a Label

Always save your label during the design process. 

To save a label, do the following: 

1. Click the  button.

2. Type in the name of the label. For example, type label for the name of the label.
The name of the label appears in the program caption.

Use Alignment Tools

You have placed the objects on the label. Now you want to make sure they are aligned on the 
horizontal center of the label. You can align objects on the label by using the Align Toolbar on 
the right side of the working window.

To align objects on the label, do the following:

1. In the Toolbox, choose a select arrow and draw a frame around all objects to select all 
objects.

Note • The first object you select determines the alignment orientation for all selected 
objects.

Figure 25 • Selecting the objects on the label

2. To arrange the objects, click the Center Align button  in the Design toolbar. The 
selected objects will be rearranged and positioned, centered to first object that was 
selected.

Note • The Align Toolbar has other alignment commands available in the Align Toolbar. 
You can also align the objects to the label grid. The option Snap to Grid is available in the 
View menu.
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Use Drawing Tools

Now you will insert a line to separate a text object from other objects and a rectangle around 
the picture object.

1. From the Toolbox, select the  button and move the cursor to the 
required starting point of the line.

2. While drawing the line, press and hold down the mouse button. Move the mouse to the 
end position of the line and release the button. The Line object is placed on the label.

3. In the Toolbox, click the  button and point the mouse to the 
upper left corner of the picture.

4. While you stretch the rectangle to the lower right corner of the picture, click and hold the 
mouse button.

5. To change the thickness of the vertical and horizontal line, double-click on the rectangle 
object to open its properties. Select the thickness you want and click the Finish button.

6. To edit the drawing object, double-click on the line or rectangle to open the dialog box 
with its properties.

The label should show the following:

Figure 26 • Label with fixed objects
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Add Variable Fields

Overview

You may want to print a label on which the data changes for each label. ZebraDesigner Pro 
offers different variable fields (counters, date/time fields, operator’s input from the keyboard) 
that you can use with text, graphics, and bar code objects.

For this example, a new label was created. The steps in the following topics explain how to 
create a label that contains a prompted field, a counter, and date/time fields. 

The captions in the following screenshots were added separately.

Figure 27 • The left label shows design mode, the right two labels are two 
consecutive labels from print preview

Create Keyboard Entry Variable Fields

The content of a prompted field can be different for every print job. Before you print the label, 
you enter the value for the field.

1. To display a list of available variable types, click the small arrow next to the 

 button in the Toolbox.

2. From the list, select New Keyboard Input and click on the label where you want to 
position the object.
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A dialog box with the Variable Wizard opens.

Figure 28 • Creating new keyboard input variable field

Note • Some of the entries in the image are only available in ZebraDesigner Pro.

3. Type Lot Number: to define the prompt that the user will see at print time. 

4. Click the Finish button. 

The text object is placed on the label and linked to the new variable.

Note • When you print the label, you are prompted to enter the product name, which is 
shown in preview on the label and on the printed label.
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Create Serialized Data Variable Fields (Counters)

Now create a counter field on the label. The value of that variable field automatically increases 
by one on every label. Typically, the counter increases by 1 on each label. For example, 1, 2, 3, 
4, 5, etc. You can also define different incremental steps.

1. To display a list of available variable types, click the arrow in the  
button in the Toolbox.

2. Select New Counter from the list. The Cursor changes to an arrow with a text object. 

3. Click on the label where the counter field should be placed. 

A dialog box with counter properties opens.

Figure 29 • Creating new counter variable field

Note • Some of the entries in the image are only available in ZebraDesigner Pro.
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4. Leave everything as default so that the counter will always start from 1 and increase by 
one on each label.

5. Click the Finish button.

The new variable is linked to the text object on the label.

Note • The use of hardware counters in linked fields is only supported in EPL printers. 
Using hardware counters in any other printers will result in the counter being removed 
from the list of linked fields. If the label is created for an EPL printer, all internal counters 
in linked fields are converted to software counters.
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Create Date and Time Variable Fields

Content of the variable field can be filled automatically with the date or time stamp from the 
computer clock or printer clock (for supported printer models).

1. To display a list of available variable types, click the small arrow next to the 

 button in the Toolbox.

2. From the list, select New Date Field. A dialog box with date properties opens.

Figure 30 • Creating new variable date field

Note • Some of the entries in the image are only available in ZebraDesigner Pro.

3. Leave everything as default, and the date will be used on the label using the format as 
defined in your Windows operating system.
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4. Click Finish.

To place a time field on the label:

5. To display a list of available variable types, click the small arrow next to the 

 button in the Toolbox.

6. From the list, select New Time Field. 

7. Click on the label where the counter should be placed.

8. Leave everything as default and the time will be used on the label using the format as 
defined in your Windows operating system.
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9. Click Finish.
The new variable is linked to the text object on the label.

The date and time fields are updated when you preview or print the label. In this example, the 
values come from your computer’s system clock.
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Use Prefix or Suffix Options

You can add a prefix and suffix to each variable field on the label. Both are added to the value 
when you preview and print the label.

To add the suffix to the variable field on the label, do the following:

1. To display a list of available variable types, click the arrow in the  
button in the Toolbox.

2. From the list, select New Keyboard Input. A dialog box with variable properties will open.

3. Type the text Enter product weight for the Prompt text for this variable field option. 

4. Set the Format to Numeric and click Next.

5. Enter kg for the Suffix option.

Figure 31 • Defining the prefix and suffix

Figure 32 • Defining the variable suffix
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6. Click Finish.

7. Click on the label where you want to position the Keyboard Input field.
The text object is placed on the label and linked to the new variable. When you preview or 
print the label, the suffix kg will be appended to the entered value on the right side.

Designing an RFID Smart Label

Overview

The concept of RFID (Radio Frequency IDentification) can be simplified to that of an 
electronic bar code. First emerging in the 1980’s, RFID was primarily used to track objects in 
industrial environments where bar codes were unable to sustain the harsh surroundings. Today, 
RFID is being used to track proprietary assets, automate access control and has many more 
additional fields of usage.

Some thermal printers have the ability to program a RFID tag at the same time as they are 
printing the label. Two different technologies and their encoding methods are joined on the 
same label. Of course a label must have embedded a RFID tag. The tag is paper thin, flexible 
and small in size which allows it to be placed inconspicuously under the label. It consists of an 
etched antenna and a tiny chip that can store ID number or your custom data in larger 
quantities. This contrasts with a bar code label, which does not store any enhanced 
information, but merely some code number.

RFID refers to technologies that use radio waves to automatically identify individual or groups 
of items. The labeling software and ZebraDesigner driver support programming and printing 
of RFID tags embedded in a label. 
Note • You can use RFID functionality in the labeling software only if you have installed a 
Zebra Driver with RFID support. Make sure you install the Zebra Driver for your RFID printer 
before you design and print an RFID smart label. RFID functionality is only available with 
ZebraDesigner Pro.
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Create RFID Smart Label

1. Click on  button in the Standard toolbar. Label Setup Wizard will start.

2. Select the printer that supports RFID smart label printing. 

3. Click on the Finish button. 

You will see that RFID Tag command is enabled in the Toolbox on the left side of the label 
design environment.

Figure 33 • RFID Tag is available for use

4. Click on the RFID Tag option in the Toolbox and define the data you want to encode into 
the RFID tag.
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Encode RFID Tag

The RFID tags embedded into the label are usually of two types: ISO tags, which encode 
blocks of data; or UHF tags, which can encode one string of data.

1. In the Toolbox to begin encoding the data, click on . 

The RFID tag dialog box opens.

Figure 34 • Encoding contents for RFID Tag

2. Select the type of the RFID Tag you want to use from the list box on the top of the dialog 
box. Click on the Tag Settings button to review RFID tag contents and define the 
encoding advanced properties.

3. Enable the option Write data to RFID tag if you want to program the tag at the same time 
as the label is printed.

Note • If you don’t select this option, the definition of tag content is saved but not sent to 
the printer.

4. Select the appropriate entry from Data Fields section.
For RFID Gen2 tags, you are able to select from different data fields. For other RFID tags 
usually only one data field is possible - RFID Tag Memory.

5. Go to the first available block in the section Data Blocks and click on the Data cell in the 
table.

Note • You might not see the table-like structure. Instead you can see edit fields to enter 
the RFID data. The type of data that can be entered depends on the type of RFID tag that 
has been selected.
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6. Type in the value you want to encode into this block. Repeat the process for other blocks.

7. Click on the OK button. A schematic view of the RFID Tag antenna will open in the label 
background identifying the definition of the RFID data on the label.

8. You can continue designing the smart label with non-RFID data as described in the 
previous sections.

Figure 35 • RFID Tag antenna in the background

When you print the label, the RFID data will be sent to the printer. The printer prints the RFID 
smart label and programs the RFID tag embedded into the label at the same.
Note • The labeling software can work with Unique RFID Tag numbers. Each RFID tag has 
embedded a unique serial number. Some printers can read the Unique RFID Tag number and it 
can be used on the label linked with some label objects.
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Support for RFID Tags

With the labeling software you can program RFID tags of different manufacturers. It is 
important to use a ZebraDesigner printer driver. You cannot program RFID tags, if you do not 
use the ZebraDesigner Driver.

ZebraDesigner Driver will let the labeling software know which types of RFID tags the printer 
supports.

Not all tag types are always available. The kind of RFID tags that will be available depends on 
the selected printer model. There are generally two types of tags:

• ISO tags (TagIt, iCode, ISO...): These are block oriented tags. The data can be encoded in 
multiple blocks.

• UHF tags (EPC): The data is encoded in one block of data.

You can input content for RFID tags using different methods, depending on the tag type (UHF 
or ISO).

For UHF tags

Data type: Data type of the selected tag can be specified here.

Data source: Incoming data that is encoded in the tag can be a fixed value or acquired from 
some variable, defined in the label.

Data size: The currently used data is previewed here. You can see the amount of space still 
available in the tag. The occupancy of the tag is seen graphically with growing bar and 
numerically with the digit, explaining the number of already used bytes.

Block locked: If you set the block as locked, the data will be permanently encoded into the tag. 
You will not be able to erase this block to re-program it with some other value. Use this option 
with caution!

For ISO tags

The blocks that are dimmed and inaccessible are reserved blocks that cannot be used.

Block Number: The successive number of block in the tag.

Data source: Select where the data block will receive the data from. It can be Fixed, where 
you will manually type in the data or can be Variable, where the value is acquired from some 
variable defined in the label.

Data: Type in the tag value manually, if the selected data type is Fixed. Select the variable 
defined in the label, if the selected data type is Variable. If your variable length is greater than 
the block size, the next block will automatically be reserved for the data.

Size: The currently used data is previewed here. You can see the amount of space still 
available in the tag. The occupancy of the tag is seen graphically with growing bar and 
numerically with the digit, explaining the number of already used bytes.
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Data type: The data can be encoded as ASCII string or as HEX encoded string.

Locked: If you set the block as locked, the data will be permanently encoded into the tag. You 
will not be able to erase this block to re-program it with some other value. Use this option with 
caution!

RFID Tag Locking

Tag locking is not available for all tag types, printers, and drivers. If the Locking Settings... 
button is not displayed in the RFID tag dialog window, you may be using an unsupported 
RFID tag type, printer, or driver. The locking settings are available for some GEN2 tag types. 
For more information, see your printer and driver documentation.

RFID tag locking enables the user to lock the RFID tag, so that no changes can be made to it 
without unlocking the tag first. If the tag is permanently locked, it is not possible to unlock it, 
and the RFID tag can never be changed.

Preserve original locking setting: The original locking setting cannot be retrieved, but the 
default option assumes that the tag setting should remain unchanged.

Lock: The RFID tag is locked and further changes to it are prevented.

Unlock: The RFID tag is unlocked, so that it can be changed.

Relock: The RFID tag is unlocked, the changes are applied, and the tag is locked immediately 
after.

Permanent lock/unlock: Checking this box will apply your selection above permanently and 
prevent later changes to it. This setting cannot be undone.

RFID Tag Settings

Tag Information: This section provides the information about the selected tag type. You can see 
the structure of the selected RFID tag. The outlook of the information depends on the selected 
type of the tag. For RFID Gen2 you will see table-like structure with the information about the 
available data fields, number and size of the block, read or write support.

For other RFID tags, you can review the following structure:

Number of blocks: The number of blocks that are available in the RFID tag.

Reserved blocks: The number of blocks that cannot be accessed and used. 

Block size: The size of each block (in bytes).

Unique RF Tag: This property is set to Yes, if you have the printer and/or the tag type that can 
provide you with the Unique Tag ID. Each tag has a unique ID encoded already in the 
production line. If your printer can read this information from the tag, you can use it with the 
label objects using RFID Tag Contents contents provider.

For example: The printer scans Unique Tag ID, remembers it and prints it on the label encoded 
in a bar code element. The value of Unique Tag is never returned to the labeling software. It is 
handled internally by the printer.
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RFID Tag Data Read: This property is set to Yes, if you have the printer and/or the tag type 
that allows the extraction of the encoded data. You can extract all or part of the data encoded in 
the RFID tag and use it with the label objects.

Tag Settings: This section provides more control for RFID programming.

Antenna offset: To achieve better programming accuracy use this option to define the offset 
for the antenna in the printer. The Offset is the distance from the antenna to the embedded tag 
on the label. This option will help you program the tags more accurately.

Maximum tags to stop: When the programming of the RFID tag fails, usually the word 
"VOID" is printed on the label. With this option you can specify how many tags can be 
programmed incorrectly. The option can be used as a precaution measure to prevent endless 
consumption of labels.

Number of retries: The number of times the printer will try to program the tag if first attempt 
fails. The parameter is sent to the printer with the rest of the data.

Check for a valid tag: Before the tag programming begins, the printer will verify if there is a 
proper RFID tag available in the smart label. The printer will also verify if the tag can be 
programmed at all. If the printer cannot check the currently selected RFID tag, the option will 
not be accessible. 

Verify data write: Once the data has been encoded into the RFID tag, the printer will check if 
the written data is equal to the original value.

Electronic Article Surveillance (EAS) settings

EAS is not available for all printers and drivers. If your RFID Tag Settings do not include EAS 
Settings, you may need to update your printer driver or select a different printer. For more 
information, see your printer and driver documentation.

Preserve original EAS setting: The original EAS setting cannot be retrieved, but the default 
option assumes that the tag setting should remain unchanged.

Enable EAS: Enable Electronic Article Surveillance in the RFID tag. If this was the original 
setting, the tag will remain unchanged.

Disable EAS: Disable Electronic Article Surveillance in the RFID tag. If this was the original 
setting, the tag will remain unchanged.

Permanently lock EAS tag setting: Checking this box will permanently lock the chosen setting 
for the EAS. This lock cannot be undone.
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Change Printer Settings

Change Common Printer Settings

When you start designing a label, tell ZebraDesigner Pro what printer to connect the label to. 
Each label file remembers the printer settings for the selected printer driver on the label.

This example shows you how to change the printing speed and darkness. 

To change the printer settings, do the following:

1. From the File menu, select Printer Settings. 
The window with the printer settings opens.

2. Open the Options tab.

3. Change the Speed and Darkness options. 

4. Click the OK button.

5. To save the label, click the  button in the Standard toolbar, or from the menu select 
File > Save.

Figure 36 • Printer driver properties

Note • Any changes in the printer settings dialog box will be saved to the label and 
applied to future print actions.
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Change Dithering Options

Dithering is a process of converting color or gray scale pictures to black and white pictures 
that can be printed on thermal printers. Thermal printers normally cannot print color images 
and can either print a dot on the label or not. There are no intermediate shades of gray.

During the dithering process all colors and shades of gray in the picture are converted to black 
and white dots, creating the illusion of new colors and shades by varying the pattern of dots. 
Different shades of gray are produced by varying the patterns of black and white dots. There 
are no gray dots at all. In printing, dithering is usually called halftoning. Shades of gray are 
called halftones.

To change the dithering settings, do the following:

1. From the File menu, select Printer Settings. 
The window with the printer settings will open.

2. Open the Dithering tab.

3. Change the Dithering Type option to suit your needs. Look at the preview on the right side 
to see the result of your selection on the label.

4. Click the OK button.

5. Save the label by clicking the  button in the Standard toolbar or selecting Save in the 
File menu.
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Using Toolbars

Use the Standard Toolbar

Click on the buttons in the standard toolbar to execute the following actions:

Create new label

Open existing label

Save currently opened label

Cut the selected objects to clipboard

Copy the selected objects to clipboard

Paste the objects from the clipboard

Undo last action

Redo last action

Access to the print functionality. Click on the small arrow in the 
toolbar for more commands

Access to the zoom functionality. Click on the small arrow in the 
toolbar for more commands

Access to the view functionality. Click on the small arrow in the 
toolbar for more commands

Access to the databases. Click on the small arrow in the toolbar for 
more commands

Open the help file
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Use the Toolbox

To use the Toolbox, do the following:

1. Click on the icon in the Toolbox to select the object.

2. Move the mouse over the label. Notice how the cursor has changed.

3. To place the selected object, click on the label where you want to place the object.

Some objects have additional shortcuts on the right side of the icon. Using this shortcut, you 
can quickly create a new object with fixed content, create a new variable and connect it to the 
selected object, or connect the object to one already defined variable.

Use the Text Toolbar

You can use the text toolbar to quickly format the text objects on the label.

To format text objects, do the following:

1. Select the text object by clicking it.

2. Click the appropriate shortcut button in the text toolbar.

3. To change the font, select the appropriate font from the list in the list box.

Note • You can limit the display of fonts in the list. You can list all fonts on the system, 
only graphic fonts (TrueType, OpenType, Type 1, bitmap Windows fonts,) or only thermal 
printer resident fonts. Click on the two icons next to the list of fonts.
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4. To change the size of the text, click on the list with font sizes and select the appropriate 

size. You can also click on the  and  buttons that will increase/decrease the size 

of the font to the next size.

Note • You can also change the fonts size directly on the label by resizing the text element 
with a mouse.

5. To format the text bold, italic, or underline, click on the appropriate formatting buttons.

6. To change the alignment of the text object, click on the appropriate alignment buttons.

Note • These buttons are accessible only for multi-line text objects.

Use the Design Toolbar

The design toolbar is used for:

• Changing color of the objects.

• Aligning objects.

• Rotating objects.

• Arranging objects.

Formats the selected text in bold style

Formats the selected text in italic style

Formats the selected text in underline style

Aligns text to the left edge

Aligns text to the horizontal center

Aligns text to the right edge
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Defining Objects

Define the Text Object

To place the text object on the label, do the following:

1. In the Toolbox, click the Text button.

2. Click the position on the label where you want to place the object.
The Text Wizard dialog box opens.

3. Define the contents for the text object.

4. To advance to the next step of the wizard, click the Next button.

5. Follow the onscreen instructions in the next steps.

6. Click the Finish button.

Note • To edit the object, select it, then double-click it. The wizard with properties 
appears.

Define the Bar Code Object

To place the bar code object on the label, do the following:

1. In the Toolbox, click the Bar Code button.

2. Click the position on the label, where you want to place the object.
Bar Code Wizard dialog box opens.

3. Define the contents for the bar code object.

4. To advance to the next step of the wizard, click on the Next button.

5. Follow the onscreen instructions in the next steps.

6. Click the Finish button.

Note • To edit the object, select it then double-click it. The wizard with properties 
appears.
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Define the Picture Object

To place the picture object on the label, do the following:

1. From the Toolbox, click on the Picture object.

2. Click on the label where you want to place the picture.
The Graphics Wizard dialog box opens.

3. Browse for the picture on the hard disk, then click the Open button.

Note • To edit the object later, select it, and then double-click it. The wizard or dialog box 
with properties appears.

Define the Rectangle Object

To place the rectangle object on the label, do the following:

1. In the Toolbox, click the Rectangle button.

2. Click the position on the label where you want the upper-left position of the object to be 
set.

3. Drag in the bottom-right direction until the object size is correct.

4. The other method of positioning the rectangle object on the label is selecting the 
Rectangle tool and then clicking the label. A default-sized rectangle will appear, and you 
can resize it using handles around the object.

Note • If you want to draw a square, grab a handle on one of the rectangle corners, 
simultaneously press and hold the Shift key, then resize the rectangle. A square will be 
drawn. For more useful shortcuts available in the software, see Shortcuts.

5. To move a rectangle to a different position, select it and drag it elsewhere on the label.

Note • To edit the object, select it then double-click it. The dialog box with properties 
appears.

Define the Line Object

To place the line object on the label, do the following:

1. In the Toolbox, click on the Line object.

2. Define the line starting point by clicking the mouse at the start position.

3. Move the cursor to the end point while holding down the mouse button.
A line will be drawn from the left to right side of the label.

Note • To draw a vertical line, click the starting point and then drag the cursor in the up-
down direction.

Note • Database, Visual Basic Expression and RFID Tag Contents fields are only 
available in ZebraDesigner Pro.
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Define the Ellipse Object

To place the ellipse object on the label, do the following:

1. In the Toolbox, click the  button.

2. Click the position on the label where you want the upper-left position of the object to be 
set.

3. Drag to the bottom-right direction until the object size is correct.

4. The other method of positioning the object on the label is selecting the Ellipse tool and 
then clicking the label. A default-sized ellipse will appear, and you can resize it using 
handles around the object.

Note • To draw a circle, grab a handle on one of the ellipse corners, simultaneously press 
and hold Shift key, then resize the ellipse. A circle will be drawn. For more useful 
shortcuts available in the software, see Shortcuts.

5. To move an ellipse to a different position, select it and drag it elsewhere on the label.

Define the Inverse Object

To place the inverse object on the label, do the following:

1. In the Toolbox, click on the  button.

2. Click the position on the label where you want the upper-left position of the object to be 
set.

3. Drag to the bottom-right direction until the object size is correct.

Note • To draw a square, grab a handle on one of the rectangle corners, simultaneously 
press and hold the Shift key, then resize the rectangle. A square will be drawn. For more 
useful shortcuts available in the software, see Shortcuts.

4. To move an inverse object to a different position, select it and drag it elsewhere on the 
label.
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Using Text Wizard

Text Wizard

Figure 37 • First screen of Text Wizard

The Text Wizard guides you to define all parameters for the text object.

Fixed text: Select this option if you would like to have a fixed non-changeable content of the 
object. If you select this option, you can enter the text directly in this dialog box.

Variable text: Select this option if you would like to have variable content in the object. 
Defining the content is defined in the next step.

Element name: Each text object on the label has a unique name. You can refer to the names 
when you are linking fields together.

Not printable: If the object is marked as not printable, it is visible on the label during the label 
design but is not printed.

Font: Currently selected font type is shown in this field.

• Inverse: Enable this option to use the text in inverse.

Note • The option is not available for all printers.

• Select button: You can select different font types for this text object among available fonts 
in the system.
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Figure 38 • Text Wizard - Choosing variable text

Note • The Database, Visual Basic expression, Linked Fields, and RFID tag contents field 
types are only available in ZebraDesigner Pro.

Select the type of the variable field you want to use.

The next page of the wizard depends on your selection here.
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Text Wizard - Keyboard Input

Use this variable type when you want the operator to enter a value of the variable from the 
keyboard before printing the specified number of labels.

Figure 39 • Dialog box for Text Wizard when Keyboard input option is chosen

Prompt text for this variable field: Fill in the message that will be shown to the user when he 
enters the values for the variable field.

Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field.

Value is required: Check this box, if you wish to set this variable value as a requirement for 
label printing.

Format: Select the format of data, currency, and rounding settings (if applicable) for the 
variable field.
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On this page of the wizard, you define the counter variable.

Figure 40 • Dialog box for Text Wizard when Counter option is chosen

Starting Value: Set the starting value for the counter. The counter will increment or decrement 
from the starting value.

Available counters: When adding a text object, the user is prompted to define whether this will 
be a fixed or variable value object. If the Variable action is chosen, and then the date or time 
option the user can decide between the computer time and value offsets. If the checkbox "Use 
the printer’s internal counter" is checked, the variable counter will be set by the printer to the 
time of printing. The variable field must use a native printer font for the counter to work.

Prompt for value before print: Click this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown before printing.

The message will be shown on the screen each time the label is to be printed. 

Set maximum number of digits: Define whether the maximum length of digits the counter can 
occupy.

Increment or decrement: Define that the variable value will increase from label to label, or 
decrease.

Preview: The field shows the preview of the counter based on your selection.
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Text Wizard - Counter Continuation

Step: Define the step for your counter. The counter will increase by this number on every 
label.

Change value every <n> labels: Define the number of label when the counter will change 
value.

Rollover when reached: Enter the value, which when reached, will cause the counter to reset 
the value to the starting value.

Use the printer’s internal counter: Enable this option to use the internal counter built into the 
printer. Using this option increases printing speed by reducing the quantity of information 
exchanged between the computer and the printer.
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Define the properties of the date field. The field will get the value from the computer clock.

Figure 41 • Dialog box for Text Wizard when Date field option is chosen

Format: Select the format for your date from the list. You can also enter a custom format.

Date offset: You can add a certain number of days, months, or years to a current date and print 
that date instead of the current one.

Preview: The printer will print the date as shown on the Preview field. This allows you to see 
how the selected date format will look on the label.

Use the printer’s internal clock: Enable this option to recall the date information from the real 
time clock (RTC) built in to the printer not the clock from the computer. The list of available 
date formats changes accordingly to the capabilities of the selected printer.
Note • You must format the current text object in an internal printer font to be able to use the 
printer’s internal clock option.
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Text Wizard - Time Field

Define the properties of the time field. The variable field will get the value from the 
computer’s clock.

Figure 42 • Dialog box for Text Wizard when Time field option is chosen

Format: Select the format for the time from the list. You can also enter a custom format.

Time Offset: The time offset settings allow the time field to be offset from the system clock. 
Enter the duration for which you wish to increase or decrease the time on the label.

Preview: The printer will print the time as shown in the Preview field. This will allow you to 
see how the selected date format will look on the label.

Use the printer’s internal clock: Enable this option to recall the time information from the Real 
Time Clock (RTC) built in to the printer not the clock from the computer. The list of available 
time formats changes accordingly to the capabilities of the selected printer.
Note • You must format the current text object in an internal printer font to be able to use the 
printer’s internal clock option.
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Text Wizard - Database

Variable field linked to a database gets the value from the specified database field.

Figure 43 •  Database Properties dialog

Define: Click this button to open the database wizard that will help you define the link to the 
database.

Field: Choose one of the available database fields as a source for the variable field.

Length: Define the maximum length of the string in the variable. If a field in the database 
contains more characters, they will not be printed. This option is useful if the field length in 
your database is not fixed (for example tab delimited ASCII file) or if you don’t want to 
reserve space for all the characters in database’s field.
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Text Wizard - Linked Field

Select this type of field to merge the contents of selected variable fields into one field. The 
selected input variable fields are combined values and used as the value for the current object.
Note • Concatenated linked fields used with EPL-based printers can only be used with the 
Export to Printer function.

Figure 44 • Linked Element dialog

Available objects: The drop down menu contains the list of all defined variable fields on the 
label. You can select the fields and click the Add button to add them to the resulting field.

Selected objects: The Selected Objects list box contains the names of the selected variable 
fields, whose values are merged into the resulting field. Click the up and down arrow buttons 
to change the relative position of the selected variable fields within the merged value.

Delimiter: Select the optional separator character that will be included between the merged 
variable fields.
Note • When you are merging the variable field containing time or date value from the printer 
Real Time Clock, ensure the fields positioned before and after the Real Time Clock field do 
not exceed 31 characters.
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Text Wizard - RFID tag Unique ID

Printers with RFID functionality can program RFID tags embedded in the labels. Each RFID 
tag has a unique ID number that was programmed into the tag during the manufacturing 
process. The Unique number cannot be altered, but the RFID-enabled printer can read it.

RFID tag Unique ID functionality allows you to read the unique ID number from the RFID tag 
and use the content with the selected bar code object. When the label is printed, the printer will 
first read the unique ID from the tag and then immediately use the value with the bar code 
object.

RFID tag Unique ID can only be used with the bar code objects that are printed as internal 
printer objects. You must format the bar code object to use internal fonts not TrueType fonts.

Figure 45 • RFID Tag dialog

Selected RFID tag: Select the tag from the list.
Note • Only tags supported by the currently selected printer are listed.

Read Source: Select the source of the RFID data.

Data Format: Select the format of the data.

Preview (WYSIWYG only): Because RFID tag Unique ID information is not returned to the 
labeling software, you do not see the actual data. Enter the data in a format similar to the 
format encoded in the RFID tag. This information will be used for preview on the label only. 
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Text Wizard - Visual Basic Expression

Select this type of field to manipulate your variable fields with the Visual Basic function. The 
result of the expression will be used with the current object on the label. You can define 
one-line expressions that must follow Visual Basic programming syntax.

Look at the samples in the dialog box for ideas of what can be done with the Visual Basic 
script.

Figure 46 • VB Expression dialog

Expression: Enter the Visual Basic expression. Include the names of the variable fields in the 
straight quotes.

Build Expression: Click this button to open the Expression Builder text editor with reference 
to frequently used Visual Basic functions.

VB Script Help: Click this button to open the Microsoft help files explaining syntax and usage 
of Visual Basic scripting.

Example • The Visual Basic expression functionality can be used for merging text fields or to 
perform simple mathematical operations.
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Text Wizard - Prefix and Suffix

The variable element can have prefix and suffix values. The prefix text is placed in front of the 
variables value. The suffix text is placed at the end of the variables value.

Figure 47 • Setting Prefix and Suffix string for the variable text element

Note • If you leave the edit fields empty, the prefix/suffix will not be used.

Prefix and suffix can be used in situations where they are required only if the variable has a 
value set. If the variable is empty, the prefix/suffix will not be printed.
Note • When you use the printer Real Time Clock for date or time fields, the length of prefix 
and suffix cannot exceed 31 characters.
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Using Bar Code Wizard

Bar Code Wizard

Figure 48 • First page of Bar Code Wizard

The Bar Code Wizard guides you to define all parameters for the text object.

Fixed bar code data: If you would like to have fixed non-changeable content for the text 
object, select this option. If you select this option, you can enter the text directly in this dialog 
box.

Variable bar code data: If you would like to have variable content for the text object, select 
this option. Defining the content is defined in the next step.
Note • When entering values for RSS composite bar codes, you need to provide the value for 
the linear and composite (2D) parts at the same time.

Use the following syntax for entering values for RSS composite bar codes. The pipe character 
(|) is used to distinguish between the components.

Syntax: <linear part>|<composite part>

Example • 12345|description

Element name: Each bar code object on the label has a unique name. You can refer to the 
names when you are linking fields together.
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Not printable: If the object is marked as not printable, it is visible on the label during the label 
design, but is not printed.

Bar Code Type: Click on the Define button to select the bar code type you want to use on the 
label.

Bar Code Wizard - Choosing Variable Bar Code

Select the type of variable field you want to use.

The next page of the wizard depends on your selection.
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Bar Code Wizard - Keyboard Input

Use this variable type when you want the operator to enter a value for the variable from the 
keyboard before printing the specified numbers of labels.

Prompt text for this variable field: Fill in the message that will be shown to the user when they 
enter the value for the variable field.

Value is required: User is require to enter a value for this field, if checked.

Format: Select the format of data you allow to be entered for the variable field.

Set maximum number of characters: Define the maximum length of characters that can be 
entered for the variable field.
13857L-003  11/29/2011



95Designing Labels
Using Toolbars
Bar Code Wizard - Counter

On this page of the wizard, you define the counter variable.

Starting Value: Set the starting value for the counter. The counter will increment or decrement 
from the starting value.
Note • You can enter only digits for the starting value.

Prompt for value before print: Click this option to enable entering the starting value of the 
counter when you start printing labels. Enter the text that will be shown to the user before 
printing.

The message will be shown on the screen each time the label is to be printed. 

Set maximum number of digits: Define the maximum length of digits the counter can occupy.

Increment or decrement: Define whether the variable value will increase from label to label or 
decrease.

Preview: The field shows the preview of the counter based on your selection.
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Bar Code Wizard - Counter Continuation

Step: Define the step for your counter. The counter will increase by this number on every 
label.

Change value every <n> labels: Define the number of labels, when the counter will change 
the value.

Rollover when reached: Enter the value, when reached, will cause the counter to reset the 
value to the starting value.

Preview: Shows the first 10 values of the serial number.

Use the printer’s internal counter: The printer will increment the serial number.
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Bar Code Wizard - Date Field

Define the properties of the date field. The variable field will get the value from the 
computer’s clock.

Format: Select the format for your date from the list. You can also enter a custom format.

Date offset: You can add a certain numbers of days, months, or years to a current date and 
print that date instead of the current one.

Preview: The printer will print the date as shown in the Preview field. You can see how the 
selected date format will look on the label.

Use the printer’s internal clock: The printer’s internal clock for the field data.
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Bar Code Wizard - Time Field

Define the properties of the time field. The variable field will get its value from the computer 
clock.

Format: Select the format for your date from the list. You can also enter a custom format.

Time offset: You can add a certain numbers of hours, minutes, seconds to a current time and 
print that time instead of the current one.

Preview: The printer will print the time as shown in the Preview field. You can see how the 
selected date format will look on the label.

Use the printer’s internal clock: The printer’s internal clock for the field data.
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Bar Code Wizard - Database

Variable field linked to a database gets the value from the specified database field.

Define: Click this button to open the database wizard that will help you define the link to the 
database.

Field: Choose one of the available database fields as a source for the variable field.

Length: Define the maximum length of the string in the variable. If the field in the database 
contains more characters, they will not be printed. This option is useful if the field length in 
your database is not fixed (for example, a tab delimited ASCII file), or if you don’t want to 
reserve space for all the characters in database’s field.
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Bar Code Wizard - Linked Field

Select this type of field to merge the contents of the selected variable fields into one field. The 
selected input variable fields are combined values and used as the value for the current object.
Note • Concatenated linked fields used with EPL-based printers can only be used with the 
Export to Printer function.

Available objects: The combo box contains the list of all defined variable fields on the label. 
You can select the fields and click the Add button to add them to the resulting value.

Selected objects: The list box contains the names of the selected variable fields, which will be 
merged into the resulting value. Click the up and down arrow buttons to change the relative 
position of the selected variable field within the merged value.

Delimiter: Select the optional separator character that will be included between the merged 
variable fields.
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Bar Code Wizard - RFID tag Unique ID

Note • This feature is only available with ZebraDesigner Pro.

Printers with RFID functionality can program RFID tags embedded in the labels. Each RFID 
tag has a unique ID number that was programmed into the tag during the manufacturing 
process. The Unique number cannot be altered, but the RFID-enabled printer can read it.

RFID tag Unique ID functionality allows you to read the unique ID number from the RFID tag 
and use the content with the selected bar code object. When the label is printed, the printer will 
first read the unique ID from the tag and then immediately use the value with the bar code 
object.

RFID tag Unique ID can only be used with the bar code objects that are printed as internal 
printer objects. You must format the bar code object to use internal fonts not TrueType fonts.

Selected RFID tag: Select the tag from the list.
Note • Only tags supported by the currently supported printer are listed.

Read Source: Select the source of the RFID data.

Data Format: Select the format of the data.

Preview (WYSIWYG only): Because the RFID tag Unique ID information is not returned to 
the labeling software, you do not see the actual data. Enter the data in a format similar to the 
format of the RFID tag. This information will be used for preview on the label only.
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Bar Code Wizard - Visual Basic Expression

Select this type of field to manipulate your variable fields with the Visual Basic functions. The 
result of the expression will be used with the current object on the label. You can define 
one-line expression that must follow Visual Basic programming syntax.

Look at the samples in the dialog box for ideas of what can be done with the Visual Basic 
script.

Expression: Enter the Visual Basic expression. Include the names of the variable fields in the 
straight quotes.

Build Expression: Click on this button to open the Expression Builder text editor with 
reference to frequently used Visual Basic functions.

VB Script Help: Click on this button to open the Microsoft help files explaining syntax and use 
of Visual Basic scripting.

Example • The Visual Basic expression functionality can be used for merging text fields or to 
perform simple mathematical operations.
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Bar Code Wizard - Prefix and Suffix

The variable element can have prefix and suffix values. The prefix text is placed in front of the 
variable’s value. The suffix text is placed at the end of the variable’s value.
Note • If you leave the edit fields empty, the prefix/suffix will not be used.

Prefix and suffix can be used in situations where they are required only if the variable has a set 
value. If the variable is empty, the prefix/suffix will not be printed as well.

Using EAN.UCC 128 Wizard

GS1-128 (EAN.UCC) Wizard

This wizard allows you to define the data structure for GS1-128 bar code. This kind of bar 
code has different areas of application that include trade items, logistic units, assets, and 
locations.

The GS1-128 bar code is an extremely flexible symbology. It allows representation of data of 
variable length, and makes it possible to encode several pieces of information in one bar code 
symbol. This is called concatenation. An Application Identifier is a field of two or more 
characters at the beginning of a data value. Application identifiers are prefixes that uniquely 
identify the meaning and the format of the data field following. The data fields are either of 
fixed or variable length, depending on the AI.
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Step 1: Choose the application identifier

Figure 49 • GS1-128 Wizard: Choosing application identifier

The dialog in the first step of the Wizard allows you to select the GS1-128 bar code data 
structure. Each bar code is composed of one or more Application Identifiers and the 
corresponding data.

Choose one of the Application Identifiers in this list. You can add, edit, or delete Application 
Identifiers from the bar code later in the process.
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Figure 50 • GS1-128 Wizard: How check digit should be applied

If you have selected an Application Identifier with data that includes a check digit (for 
example, AI (01) - GTIN, Global Trade Item Number), then first you have to select how the 
check digit will be applied. The possible options are:

• Automatic calculation: Check digit will be calculated by the application.

• Check digit to be entered with data: Manually enter the data and check digit. The 
application will verify if the entered check digit is valid.
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Step 2: Application Identifier Input Type

Figure 51 • GS1-128 Wizard: Where the data for AI is obtained from

When the Application Identifier is selected, the data source must be defined. These are the 
possible options:

• Fixed: The application identifier will have a fixed value on every label.

• New variable: The application identifier will be linked to the variable and have variable 
value on each label. You will define a new variable.
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Step 3: Enter the value for the Application Identifier (AI)

Entering fixed value for the application identifier.

Figure 52 • Entering fixed value for the application identifier

If you selected a fixed value in the previous dialog box, you should enter a value for the 
Application Identifier here. The Wizard will let you know about the required data format for 
this AI and how long the AI value should be. For some AI’s the field length is fixed to certain 
number of digits; for others, only the maximum number of possible digits is stated. You will 
also be reminded of the AI’s proper field format (numeric, alphanumeric) if you enter incorrect 
data.

Entering a variable value for the application identifier.
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Figure 53 • Creating new variable for the application identifier

If you selected new variable values in the previous dialog box, a new variable field will be 
created. You will have to provide some information about the variable being used.

Calculate the Check Digit

To select how the check digit will be calculated, do the following:

1. Enter the check digit with the data and the software will validate it.

2. The software can calculate the check digit.

Define a New Variable

Define the properties of the variable that will provide a value for the application identifier.

Prompt: Enter the text that will be displayed to the user at print time.

Format: Define the format of the variable.

Counter: If the variable will be a counter, define its properties.
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Step 4: List of selected application identifiers

Figure 54 • Listing the selected application identifiers

This is the last step of the GS1-128 Wizard. Here you can add, edit, or delete Application 
Identifiers and define a separator.

Application Identifiers selected: In this field all selected application identifiers for the bar code 
are listed in the order of creation. You can change the order with the arrow buttons.

Add, Edit, or Delete buttons: Use these buttons to add additional application identifiers and 
edit or delete existing ones.

Input Application identifier delimiter: Define left and right separators among different 
application identifiers. The default setting is to use parenthesis.

Preview: A sample bar code content based on your application identifier selection is shown 
here.

To exit the wizard, click the Finish button.
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Selecting Bar Code Type

Settings for Advanced Bar Codes

GS1-128 Bar Code

This bar code is combined from one or more input values and standard AI’s - Application 
Identifiers. Each AI must be followed by the standard values. These values can be fixed or 
variable.

When you select the GS1-128 bar code, the Bar code data field in the Bar code Wizard dialog 
box is disabled. To define the contents of the bar code, click the Next button. 

From the list of available Application Identifiers select the first identifiers. It will be written in 
brackets below the bar code.

When the Application Identifier also includes check digits, you have to define whether it will 
be calculated or entered together with data.

Next, define how you will set the values for the selected identifier. You may enter a fixed value 
or define a variable value. 

Fixed values

When values are fixed, the Wizard dialog box will inform you what to enter. 

The defined AI is presented on the list of selected Application Identifiers. Click the Add button 
to add a new AI or the Delete button to delete an existing one.

Should you need to change the AI and the data, select the AI and click the Edit button.

You can sort the listing of AI’s by using the Up and Down buttons. 

All the settings can be previewed on the Preview field. 

The separator among Application Identifiers can be defined by entering the required separator 
for the left and for the right side of the Application Identifier. The default separator is brackets.

Variable values

GS1-128 bar code supports keyboard variables – the variable data will be entered from the 
keyboard.

You can define the Prompt – the message for the operator, who will enter the data.

The data can be numeric only or all characters.

The value can be fixed or incremented/decremented on every label or a certain number of 
labels with the desired step.

The variable data will be written in the Preview field as a series of A characters.

When you are satisfied with the settings, click the Finish button to put the GS1-128 bar code 
on the label. 
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PDF 417 2D Code

General tab

X expansion factor
This option defines the X expansion of the bar code symbol.

Y expansion factor
This option defines the height of the bar code symbol.

Security tab

According to the standard, you can select among 9 levels of security. Higher security levels 
allow more reliable reading regardless of errors, but the bar code symbol is bigger.

Truncated bar codes can be used where label damage is unlikely and there is no demand for a 
high level of security. The truncated symbol is smaller.

Aspect Ratio

It is the ratio between the number of columns and the number of rows.

Contents

PDF 417 code can encode:

• Full 128 ASCII character set

• All 128 Extended ASCII characters

• 8-bit binary data

DataMatrix Bar Code

General tab

X expansion factor
This option defines the X expansion of the bar code symbol.

Y expansion factor
This option defines the height of the bar code symbol.

Aspect Ratio

It is the ratio between the number of columns and the number of rows. Select one of the values 
from the drop down menu.
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Details tab

ECC Type

Error Correction Codes define the security level. You can select one from the standard levels 
in the pull-down menu.

Format ID

This option defines which character set will be used in the bar code. You can select one of the 
formats with the following filter.

The formats from 1 to 7 allow a data length up to 500 characters, while formats from 11 to 17 
allow up to 2000 characters.

Border Size

Factors from 1 to 15 set the dimension of the border in the shape of the character L.

Data Matrix can encode:

• Full 128 ASCII character set

• All ISO characters

• All EBCDIC characters

MaxiCode 2D Code

General tab

Y expansion factor
This option defines the height of the bar code symbol.

Details tab

When the option Structured is not selected, the content of the bar code is optional. 

For Structured bar code you may encode only standard contents.

01 and 11 0..9, space

02 and 12 A..Z, space

03 and 13 A..Z, 0..9, space

04 and 14 A..Z, 0..9, space,.-/

05 and 15 7-bit ASCII lower part (from 0 to 127)

06 and 16 all

07 and 17 7-bit ASCII
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Edit Bar Code Dialog Box

This dialog box is displayed when you click the Define button on the bar code dialog box. On 
this dialog box you specify the type of bar code you want to use on the label and all additional 
advanced settings: how the bar code should be generated, if the check digit should be 
automatically calculated or not, and various other options. If the Enable preview check box is 
checked, a preview of a resulting bar code is displayed on the right side of the dialog box.

When you are satisfied with the bar codes properties, confirm the changes you made by 
clicking the OK button or reject them and keep previous settings by clicking the Cancel 
button.

The Edit bar code dialog box has several pages (tabs).

General Tab

On this tab, you can select the bar code type you want to use and the properties of the bar code.

Figure 55 • Edit bar code dialog box – General tab

Type of bar code: The required bar code symbology is selected from the tree list of available 
bar codes.

Symbol height: The height dimension of a bar code can be specified either by entering a value 
here or by resizing the bar code symbol directly on the label.

X-Expansion factor: The expansion factor defines the width of the bar code symbol.
11/29/2011 13857L-003 



Designing Labels
Using Toolbars

114
Ratio: This is the ratio between narrowest and widest bar in the bar code. It is locked for the 
majority of bar codes, but it can be changed for some.

Base object width: Shows the width of the narrowest bar in the bar code.

Print bar code as graphics: Select if bar code should be converted to a picture and sent to the 
printer as image or should the printer print bar code as an internal element. Printing internal 
bar codes will speed up label printing because less data must be transferred to the printer.
Note • If the printer does not support the selected bar code internally, the option Print bar code 
as graphics will not be available.

Check Digit Tab

This tab is used to specify if you want to use the check digit in the bar code or not. This option 
can only be modified for the bar codes that allow you to enable and disable the check digit.

Some bar code standards include the check-digit by definition and it cannot be omitted. An 
example of such bar codes are EAN and UPC bar codes, where the check digit cannot be 
disabled at all. But some codes allow you to enable/disable the check-digit.
Note • We recommend that you always include the check digit character in the bar code. It will 
increase the scanning reliability.

Figure 56 • Edit bar code dialog box – Check digit tab
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You can choose whether you want to input the check digit value, or let the program calculate it 
for you:

Auto-generate check digit: Check digit is calculated by the software. You enter the bar code 
data only. For example: when using EAN-13 bar code, you enter the first 12 digits; check digit 
in the 13th place will be calculated and added automatically.

Verify the provided check digit: Use this command when you want to enter the value for the 
check-digit. At print time, the entered check digit will be verified for validity.

Enable custom check digit algorithm: You can set a custom algorithm for calculating the 
check digit. Click on the button Select to choose the algorithm.

Human Readable Tab

On this tab, you can set the options regarding position and format of the bar code 
interpretation.

No interpretation: Bar code object does not have any human interpretation.

Below bar code: All data encoded in the bar code is placed beneath the bar code symbol as 
human readable characters.

Above bar code: All data encoded in the bar code is placed above the bar code symbol as 
human readable characters.

Font: Using the Font button, you can choose the font for auto-translation text. The option Auto 
font scaling will adjust the font of the auto translation text to the size of the bar code.
Note • You can format the font for human interpretation only if the bar code is printed as a 
graphic. When printing the bar code as an internal printer object, the printer will print the 
interpretation using resident built-in fonts.
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Contents mask sets the custom format of the human interpretation.

Figure 57 • Edit bar code dialog box – Human readable tab
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Details Tab

On this tab, you can define advanced settings for the bar code.
Note • Not all of these options are available for all bar codes and printers.

Include quiet zones: Check this field if you want the bar code to have some white space in the 
front and in the end for increased readability.

Descender bars: Some bars of a bar code will be longer than others. This is typically used 
with EAN and UPC bar codes that have longer bars in the beginning, in the middle and in the 
end of the bar code.

Mirror horizontally/mirror vertically: The bar code can be mirrored vertically and horizontally. 
The bar code will usually have to be printed as a graphic for this option to be accessible.

Intercharacter gap: Some bar codes allow you to change the gap between characters in the bar 
code (e. g. Code-39).

Include EAN white space: Before and after the bar code, a white space is inserted or not, as 
desired. It indicates the width of the bar code. If you put any other object in the area of the bar 
code, it will reduce the readability of the bar code. This option is valid only for EAN bar 
codes.

Figure 58 • Edit Bar Code – Details tab
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Supported Bar Code Types

Select Objects

To select the object on the label, do the following:

1. In the Toolbox, click the  button.

2. Click on the object on the label that you want to select.

To select two or more objects, press the Shift key, and hold down, while clicking the object 
with a mouse.

The objects can be selected, cut, copied, pasted, and edited with the right mouse button. If you 
click the right mouse button on the object, the menu shows all the available commands. Note 
that these commands are equivalent to correspondent menu commands.

You can also change the anchoring point of a selected object by holding Ctrl while clicking the 
placeholders (corners of the bounding box) of the object.

Bar Code Group Bar Code Types

EAN and UPC EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement, 
EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit 
supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 
2-digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E + 
2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), 
GS1-128, SSCC, Bookland, Addon 2, Addon 5

Linear Interleaved 2 of 5, ITF 14, ITF 16, Code 39, Code 39 Tri Optic, Code 
39 Full ASCII, Code 32, Code 93, CODE 128 (A, B and C subsets), 
MSI, Codabar, Postnet-32, Postnet-37, Postnet-52, Postnet-62, Kix, 
Pharmacode, Plessy, Anker

RSS Linear RSS symbologies
RSS14, RSS14 Truncated, RSS14 Stacked, 

RSS14 Stacked Omnidirectional, RSS Limited, RSS Expanded

Composite RSS symbologies
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked 
Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, 
EAN-8, EAN-13, GS1-128 & CC-A/B, GS1-128 & CC-C

Two-dimensional 2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, QR, 
MicroQR, Codablock F, MicroPDF, InfoGlyph
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Edit Objects

To edit the properties of the object, do the following:

1. Double-click the object on the label.
The dialog box with object properties opens.

Note • You can also press the Enter key while the object is selected.

2. Make modifications to the object properties.

3. Click the Finish button.

Move Objects

To move the object on the label, do the following:

1. Select the object.

2. Click on the object with the left mouse button.

3. Hold the mouse key down.

4. Move the position of the cursor on the screen.
The object will move with the cursor.
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Aligning Objects

First you have to select objects that you want to align.
Note • All objects are aligned relative to the first selected object.

Then click appropriate buttons in the Design toolbar to align selected objects to each other. If 
Align toolbar is not visible (by default it is located on the very right side of the window), 
enable the Design toolbar in the Toolbar option in the View menu.

You can align objects to:

You can also distribute objects evenly, so that spacing between them is equal:

Note • If you hold the CTRL key while clicking the buttons, the selected objects are aligned 
relative to the label and not to the first selected object. 

Resize Objects

To resize the object on the label, do the following:

1. Select the object.
The selected object is framed with a rectangle.

2. Click on one of the small rectangles in the corners of the rectangle.

3. Hold the mouse key down.

4. Move the position of the cursor on the screen.
The object will resize with the cursor.

Left

Right

Horizontal center

Top

Bottom

Vertical center

Horizontally

Vertically
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Rotate Objects

To rotate the object, do the following:

1. Select the object.

2. In the Design Toolbar, click the button.
The object will be rotated 90° clockwise. 

Note • If the Design toolbar is not visible in the application, enable the toolbar in the 
Toolbars section in the View menu.

Supported Graphics Formats

The following graphical formats are supported:

File extension Graphics type

BMP, DIB, RLE Windows Bitmap

GIF CompuServer Bitmap

JPG, JPEG, JPE JPEG Bitmap

TIFF, TIF, FAX, G3N, 
G3F

TIFF Bitmap

PNG Portable Network Graphics

WMF Windows Metafile

EMF Enhanced Windows Metafile

ICO Windows Icon

CUR Windows Cursor

TGA, TARGA, VDA, 
ICB, VST, PIX

Targa Bitmap

PXM, PPM, PGM, 
PBM

Portable Pixmap, GreyMap, BitMap

JP2 JPEG2000

J2K, JPC JPEG2000 Code Stream

PCX Paintbrush
11/29/2011 13857L-003 



Designing Labels
Using Toolbars

122
Grouping Objects

You can work with individual objects on the label, or you can group the objects into a group of 
objects. When you group two or more objects into a group, the objects behave as one single 
object on the label. In some cases the grouping feature will make the label design easier.

To group objects on the label, do the following:

1. Select two or more objects on the label.

2. Select Group from the Design Toolbar.
The individual objects will be grouped into one group.

Note • To ungroup the objects in a group you must use the command Ungroup from 
Transformations menu.
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Working with Variable Data

Dynamic Data Overview

You may want to print labels on which the data changes for each label, for example, counter, 
serial numbers, date, and time. To accommodate changing data, ZebraDesigner Pro can be 
used to format labels using the variable fields. Variable fields can be used with text and 
graphic objects.

There are several types of variables you can choose. Data, which must be printed as a variable, 
is prepared at the time of printing. It can be entered in the program in these ways:

• by the operator from the keyboard

• from the computer’s clock (date and time)

• from the label design (using counters with predefined starting values and steps)

• from the RFID tag embedded into the label (ZebraDesigner Pro only)

• as output of ’Linked field’ or ’Visual Basic expression’ (ZebraDesigner Pro only)

• database can be used to provide data for the fields (ZebraDesigner Pro only)

Note • The variable data can be the same for many labels and/or specific for one label 
only. 

Note • If a variable defines the label, making it absolutely necessary, it is possible to set 
the requirement, that a variable value must be entered in the field for printing to succeed. 
This option is available in the Text Wizard. For more information, see Define the Text 
Object.

Database Wizard

Working with Databases

ZebraDesigner Pro allows you to use databases in which your data is stored. Database types 
can be:

• ASCII (text file) where fields are fixed-length or are separated with any selected character

• Microsoft Excel database

• Microsoft Access database

• Existing ODBC Data Sources

You can use a single database on the same label.

Databases are very useful when printing labels with a large quantity of different data and 
variable values. You don’t have to enter values for every variable before label production any 
more; you can use previously prepared database instead. A database in the ASCII text file can 
be created in any text editor (for example Notepad), it can be also exported from other 
applications (for example Microsoft Word). You can also use Microsoft Excel to edit your 
data.
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Before you can use the data from the database, you have to link the database on the label. 
During this process, the database fields get connected to the variable fields on the label.

When you start printing labels, every variable field will automatically get the value from the 
linked database field. Each record in the database is used on a single label.
Note • Database functionality is only available in ZebraDesigner Pro.

Using Data from the Databases

Imagine that you have the following database that contains first and last names of people:

1. To use the data on the label, you must first define this database using the Database Wizard.

2. To include two variable texts on a label, create two text objects.

3. In the text wizard, select Variable text and click the Next button.

4. Select the Database option as the source of variable data.

5. Link both text objects to the variable fields, each to a separate field.

When you print the labels, each of the text objects on the label will get the value from the 
corresponding field in the database. When one label is printed, the next record is used for the 
second label and the process is repeated. Each name and surname is printed on a separate label.

Use Database Wizard

The process of defining a new Database access function consists of four steps (pages). On 
those pages you enter the data required by the Wizard. You can go to the next step (page) by 
clicking the Next button or return to previous with the Previous button. 

When all necessary data has been entered, the Finish button will become available, allowing 
you to complete the process of defining a new Database access function. Note that some 
options have predefined values, so you don’t really need to go through all the steps of a 
wizard.
Note • Database functionality is only available in ZebraDesigner Pro.

field1 field2

John Smith

Jane Wright

Bob Doe
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Select the Database File

Figure 59 • Database wizard – Selecting database file

Enter the full path name of the database file in the edit box or use the Browse button to find the 
file on your computer.
Note • You can only browse to the databases that are stored in the files. If you use databases 
through ODBC or OLE DB drivers, you will have to set up the connection parameters in the 
ODBC Data Sources administration in the Control Panel.
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Select the Desired Fields

Figure 60 • Database wizard – Selecting fields

On this page, you can select the fields you want to use on the label. All fields in a table are 
selected by default, but you will probably want to deselect some of them, especially if you 
have a large table. Variables will be created for each selected field and can later be attached to 
objects.
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Select the Records to Print

Figure 61 • Database Wizard – Selecting which records will be printed

Select the desired option for how you want to use the records in the database. By default, the 
option I want to print all records from the table is set and all records in a table will be printed 
one at a time. Each record will be printed only once.

If you do not want to print the entire database, you can select which records should be printed. 
In this case, select the option I want to select what record to print. Before printing you will be 
shown a dialog box with all records from the database. Then you will be able to select which 
records should print.

By default, records are used once for a single label. If you would like to print several copies of 
a label with database data, you can define it in the second part of the Wizard. 

One field in the table contains the label quantity information: This option will let you choose a 
field in the database that the software will use to determine how many labels to print. This 
field has the information about the quantity of labels for each record. For example, you have a 
database with records of your products. It contains a field with a numeric value where the 
required number of label copies is stored. Select this field and let the application print the 
quantity of labels specified here.

I will enter label quantity for each selected record: This option is enabled only if you selected 
I want to select what record to print in step 1. Before printing you will be able to select which 
records will be printed in the selection dialog box. At the same time, you will be able to type in 
the exact label copy for each selected record. 
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Select Variable Quantity from the Database Field

Select a field in the database that contains the label quantity information. The database record 
will be printed on as many consecutive labels as the selected field contains.
Note • Make sure to select the field that has been formatted with the numeric data.

Add Fields to the Label

Figure 62 • Database wizard – Adding fields to the label

On this page, you specify if you want the wizard to generate text objects on the label that are 
already linked to corresponding fields in the table. Text objects are created in the upper left 
corner of a label, but you can move them to another position.

Link Label to Text Databases

Overview

Text databases are text files containing data values that can be used for variable objects on the 
label. The text database is not a real database. It contains the data values but lacks the 
information of the data structure, name of the fields, and maximum lengths of the fields. You 
have to provide the missing information before ZebraDesigner Pro can use the data from such 
a text database.
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Connect to a Database

ZebraDesigner Pro offers a Database Wizard that guides you through the necessary steps to 
connect the database to a label. 

To connect your label to a database using the Database Wizard, do the following:

1. In the Standard Toolbar, click the  button.

2. Click the Browse button and point to the text database SAMPLE.TXT in the Samples 
folder.

Figure 63 • Selecting the text database

3. Click the Next button.

Note • If you connect to the database for the first time, you need to define the database 
structure. Continue with the next section.
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Format the Data with the Text File Wizard

Because text files do not contain structural information like real databases do, you must define 
the fields and their data structure. When you use the same text database again, you won’t have 
to define the structure again.

1. Choose the data type for the selected text database. The fields are delimited by comma so 
you must select the Delimited option. 

Figure 64 • Defining the type of the text database

2. Click the Next button.
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3. Review if ZebraDesigner Pro has properly auto-determined the format of the text file. The 
delimiter must be set to Comma.

Figure 65 • Defining the fields in the text database

4. Click the Next button.

5. Accept the default field names and click the Next button.

6. Review the text database structure. The field names and their maximum lengths are 
displayed. 

7. To close the Text File Wizard, click the Finish button.

The link to the database has been created, and database fields are available on the label. 

ZebraDesigner Pro brings you back to the Database Wizard.

Place Database Fields on a Label

The next step in the Database Wizard opens the dialog box with the list of available fields from 
the database. 

1. By default, all fields from the database will be used on the label. Click the Next button.

Figure 66 • Using all fields in the text database
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2. Specify what records and how many you want to print:
Select the options I want to select which record to print and I will enter label quantity for 
each selected record. Before printing labels, the table with the records will open, and you 
will be able to select the records you want to print and the quantity of labels for each 
record.

Figure 67 • Specifying what records from the database will be printed and in 
what quantity

3. Click the Next button.

4. Select if the Database Wizard should link all selected fields from the database to the text 
objects on the label or if you want to link the fields manually to the label. 

5. Click the Next button. 
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6. Select I want a text object for each selected field and click the Finish button.

Figure 68 • Each field from the database will be linked to a text object

The label will show several text objects. Every field from the database is linked with the text 
object on the label.
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Use Print Preview to Select Data and View a Label

Now you will simulate label printing using print preview.

1. In the Standard Toolbar, click on the  button.

2. The Print dialog box opens with the Quantity of labels set to Variable quantity (entered 
for each database record). This setting corresponds to your selection in the Database 
Wizard when you have selected the options I want to select which record to print and I will 
enter label quantity for each selected record.

Only the records you select will be printed in the defined quantity.

Figure 69 • Print / Print preview dialog box

3. To choose which records to print from the database, click on the Select Records button. 
The Record Selection dialog box will open.
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4. Select the records from the database you want to print and enter the number of labels you 
want to print for each selected record.

Figure 70 • Record selection dialog box

5. Click the OK button. You will return to the Print dialog box.

6. Click the Preview button. Now you can preview the labels on the screen. Note that the text 
objects on the label change for each new record.

7. In the Command window to advance to the next label or return to the previous label in the 
series, click the Next or Previous button. After you see the last label in the Preview series, 
the command window is closed.
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Print a Label

When you are certain that the label design is correct and the label preview shows the correct 
values from the database, you can start sending the labels to the printer. 

To print a label, do the following:

1. In the Standard Toolbar, click the  button.
The Print dialog box will open (same as the print preview dialog box).

2. Click the Select Records button and select the records you want to print and specify the 
label quantity for each record. 

Figure 71 • Selecting records and specifying label quantity

3. Click the OK button.

4. To start printing labels, click the Print button.

5. To close the dialog box, click the Close button.
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Text File Wizard

When the input database file is a plain ASCII text file or formatted CSV (Comma Separated 
Values), Text File Wizard will be started within Database Wizard and it will guide you through 
the steps of text data acquire. The main difference between a real database and a text file is in 
their data structure information. Databases include all information about their fields (names, 
data format, length) and can be automatically used with the application. Text files, on the other 
hand, do not have such information, and you will have to instruct the application on how the 
data is encoded.

When the Text File Wizard finishes, it will return control to the Database Wizard that will 
guide you the rest of the way.

Choose a Data Type

Before you can use text file, you will have to define its data structure. Fields can be delimited 
by a separator (tab, semicolon, comma, or some entirely user-defined separator) or can be of a 
fixed length.

Figure 72 • Database Wizard –Choosing Data Type

Choose Delimited, if you know that data fields are separated with a special character. File 
preview at the bottom of the dialog box can be helpful if you do not know exactly how the data 
is organized.
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Choose Fixed if you know that your data fields always occupy the same number of characters.

Start import at row option is useful when you do not want to import some rows at the top of the 
file. You may want to use this option when the text file contains a header on top of actual data 
fields.

Set the Fields

Figure 73 • Database Wizard –Setting separator and delimiter

In the second step of the Text File Wizard, you have to set the fields in the text file. If you have 
selected Delimited in the previous step, choose the appropriate separator here. Commonly, 
used separators are already pre-defined. But if you require some other, there is an option to use 
a custom-defined one.

You can also select the Delimiter character that is used when a separator character is used in 
the text field itself. The delimiter should be used to enclose this field. Text between two 
delimiter characters is treated as one field although it contains the field separator character.

The data preview in the bottom part of the dialog box will let you know if your choice of a 
separator character is a correct one. Fields will be separated with vertical lines if a separator is 
valid.

If you selected to have your data formatted with fixed widths, the second step of the Wizard 
will be slightly different. Instead of selecting a character for field separation, you will have to 
define field widths. Use a mouse and draw a vertical line to the start positions of the fields. 
Lines will indicate where the new field starts.
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Figure 74 • Database Wizard –Formatting the fields

In this step of the Wizard, you can review the field names and lengths. If necessary, you can 
modify them. You may use more recognizable field names so you can distinguish between 
them more easily.

When you are finished with Text File Wizard, the structure information of the used text file is 
stored to a separate file with an extension of .SCH (Scheme File). If you try to use the same 
text file on a different label, you will not have to recreate the structure. SCH files will be 
automatically used and the Text File Wizard will not be necessary.
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Work with Visual Basic Expressions

Visual Basic expressions allows you to manipulate the data values on the label. Input to Visual 
Basic can be fixed values or variable fields from the label. The output is always a data value 
that is used as content for the current object.

The expression is a one-line Visual Basic script. You can use up to 100 characters for your 
expression.
Note • The multi-line commands like "if..then..else.." cannot be used with the Visual Basic 
expression. You can use one-line expressions.

A Visual Basic expression must follow the Visual Basic script programming syntax. For more 
information on how to write your expressions, refer to the Microsoft help on Visual Basic 
scripting. Click on the button ’VB Script Help’ in VB script step in the Text or Bar Code 
wizard to open the Microsoft help.
Note • You can also open the Visual Basic reference help file VBS55.CHM in the Bin folder 
of ZebraDesigner Pro folder.

Some common samples of Visual Basic expressions:

Visual Basic 
Expression

The result Comment

1 + 4 * 20 81 Numeric calculation

"#" + 
LEFT("123456
7890",5)

#12345 Working with string 
functions

[MyField1] + 
"-" + 
[MyField2]

The values from variable 
fields MyField1 and 
MyField2 are merged 
together.

Concatenating string 
values
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The labeling software has a simple text built-in editor. You can use it to design your own 
simple Visual Basic scripts.

The Expression editor is a programming text editor with constant access to command 
reference of the script language you are currently using.

The Expression editor lets you edit your scripts and expressions with ease. The Load and Save 
buttons allow you to import / export Visual Basic scripts from / to external text files. The 
editor uses standard shortcuts for positioning of the cursor and working with text files. 
Standard Search and Replace shortcuts (Ctrl + F, Ctrl + R) are also available.

The working window is divided into four parts.

Language Help: The button will open the help file with the detailed reference of the Visual 
Basic script.

Category This section contains the groups of available commands, functions, and 
operators. Similar objects have been grouped together for easier 
identification and faster search.

The groups are displayed as a tree-view. Select the main group name to 
display all its contents into the Name section. Or you can click the plus 
sign in front of the group name (if available) to display all defined 
sub-groups. Then select the sub-group name to display only its contents.

Name This section will display the contents of the selected group in the 
Category section. All available commands, functions, operators etc. will 
be listed here. If you select one of them, its properties will be displayed in 
the Description section. If you want to insert the selected operands into 
the Expression field, double click its name or click the Insert button.

Expression This section is the main workplace of the Expression editor. Use it to 
write and modify the script you are working on.

Description This section displays the name, sample use and description of the 
currently selected operand in the Name section.

You will get an idea of how the current operand should be used.
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Using Printer Real Time Clock (RTC)

When the printer selected on the label has a built-in Real Time Clock (RTC), you can use the 
time or date fields from the Real Time Clock with text objects on the label. The available time 
and date formats are defined in the printer driver.

To use the time field from the printer RTC on the label, do the following:

1. In the Toolbox, click the Text button.

2. Click the position on the label, where you want to place the object.
Text Wizard dialog box will open.

3. Enable the Variable text option.

4. Click the Next button.

5. Select the Time Field option.

6. Click the Next button.

7. Enable the option Use the printer’s internal clock.

8. Select the appropriate time format from the list.

9. Click the Finish button.

Note • When you are using a prefix and suffix with the Real Time Clock field on the label, 
make sure that the length of the prefix and suffix does not exceed 31 characters.
When you are using a linked field and are merging a Real Time Clock field with other 
fields, make sure that the length of fields surrounding Real Time Clock field does not 
exceed 31 characters.
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The date fields can be printed in various formats. In this field, you define how the date will 
look. You can select some of the predefined date formats or enter you own. When defining the 
formats, the following notation is used:

The examples:

D Number of the day in a month. Can occupy one or two characters.

DD Number of the day in a month. Always occupies two characters (leading 
zeros will be added as necessary).

M M is number of the month. Can occupy one or two characters.

MM MM is number of the month. Always occupies two characters.

YY or YYYY The year as 2 or 4 digits.

DDD Abbreviation of the day of the week.

DDDD The full name of the day of the week.

MMMM The full name of the month.

MMM The abbreviation of the name of the month.

J The number of days since January 1. Can occupy from one to three 
characters.

JJJ The number of days since January 1. Always occupies three characters.

W The week number in the current year. Can occupy one or two characters.

WW The week number in the current year. Always occupies two characters.

Any other sequence of characters will be displayed unchanged so you can 
insert dots, commas and other characters needed to properly write the date.

Format How the date will look

D/M/YYYY 10/3/2005

DD/MM/YY 10/03/05

DDDD, D. MMMM YYYY Thursday, 10. March 2005

JJJWWYYYY 069102005
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Available Time Formats

The time can be printed in various formats. In this field, you define how the time will look. 
You can select some of the predefined time formats or enter you own. When defining the 
formats, the following notation is used:

The examples:

h Hours in 12-hour format (AM/PM will be added if they follow the time). Can 
occupy one or two characters.

hh Hours in 12-hour format (AM/PM will be added if they follow the time). Always 
occupies two characters. (leading zeros will be added as necessary).

H Hours in 24-hour format. Can occupy one or two characters.

HH Hours in 24-hour format. Always occupies two characters.

mm Used for minutes.

ss Used for seconds.

Format How the time will look

h:mm {AM/PM} 8:25PM

H:mm 20:25

hh:mm:ss 08:25:36
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The contents mask is very useful when you must display the input data differently on the label. 
With contents mask, you can reformat the data to suit your needs. Contents Mask is available 
in the Human Readable tab in bar code properties.

The mask character will be replaced by the actual data and any other used character will be 
used as-is. If the current bar code value is

"AD951"

and the contents mask is

"**C - ** /*/"

the resulting output will be

"ADC - 95 /1/"

Powerful formatting structures can be defined using Contents mask, but it is only available 
with bar codes that allow custom formatting of the human interpretation. You should also 
make sure to print bar codes as graphics; otherwise, the contents mask is not available.
If your data contains the asterisk "*" character, then you will have to change the 
default mask character to something else. It should be a unique value, not appear-
ing anywhere in the data.
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Preview Pictures

When you place a picture on the label, in design mode it is always shown in color-depth as 
defined in the picture.

However, when previewing the labels on-screen, the preview of the pictures depends on the 
dithering option set in the printer driver. All color pictures (except WMF and EMF files) are 
converted to monochrome images. The illusion of colors and shades of grey is accomplished 
by varying the pattern of dots. More dots close together will provide a darker shade of grey.

The preview of the label will show pictures in the same way as they will be printed according 
to the dithering setting. A more accurate print preview is guaranteed this way.

If the picture is not previewed as you would like to print it, change the dithering setting in the 
printer driver.

Preview and Print a Label

If you want to print a label, you can use the print preview to simulate a print output. The label 
preview shows the label on the screen.

Simulate printing 10 labels on the screen to check label layout and printing procedure.

1. In the Standard Toolbar click the  button or from the File menu select the 
Print command.
The Print dialog box appears.

2. Enter 10 for Label Quantity and click on the Preview button. 
ZebraDesigner Pro will close the dialog box and simulate the production for 10 labels on 
the screen.

Note • You can select between the quantity of the labels and the quantity of pages. The 
page can have one or more labels, and the labels are arranged on the page in columns and 
rows. If you have eight labels on the page, quantity of ten pages will print 80 labels.

When you are certain that the labels will be printed correctly and the preview shows the 
correct values, you can proceed to real printing. 

To actually print the labels, do the following:

3. In the Standard Toolbar, click the  button. 
The Print dialog box appears.

4. Enter 10 for the Label Quantity and click the Print button. 
Your printer will now print 10 labels.
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Optimize the Printing Speed

There are many factors that affect the printing speed. By following the guidelines below you 
can dramatically increase the speed of printing:

• If your printer supports parallel and serial ports, use the parallel port. Your computer can 
send data to the printer over a parallel port much faster than over serial port.

• Use the printer’s internal fonts instead of Windows’ true-type fonts. True-type fonts must 
be sent to the printer as graphics and the size of the file is much bigger (kilobytes). When 
using internal fonts, only the text is sent to the printer (couple of bytes). If you must use 
true-type fonts, use the Font Downloader program, to download these fonts to the printer’s 
memory and access these fonts as internal printer fonts (only if your printer supports this).

• When using bar codes, make sure that you do not print bar codes as graphics if your 
printer supports printing bar codes.

• When using counters, the printer will internally increment the numbers if the internal fonts 
are used (if supported by the printer). This means, that the printer will receive only the 
first number of objects, and will later increment this number to print other labels. Using 
this option also reduces the amount of data transferred between computer and printer, but 
the difference is noticeable only with high quantities of labels.

• Set the printing speed to a higher value (if your printer supports it). Note that setting the 
printing speed usually affects the quality of printing. The higher the speed, the lower the 
quality.
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Online Support

You can find the latest builds, updates, workarounds for problems and Frequently Asked 
Questions (FAQ) under the Support section on the Zebra Web site. If you cannot solve the 
problem on your own, please contact your local vendor or representative offices listed in the 
topic Contact Information.
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Technical Support via the Internet is available 24 hours per day, 365 days per year.

Web Site: www.zebra.com
Self Service Knowledge Base: www.zebra.com/knowledgebase
Online Case Registration: www.zebra.com/techrequest   

Which Department 
Do You Need?

The Americas
Europe, Middle East, 

and Africa
Asia Pacific

and India

Regional Headquarters Zebra Technologies Corporation
475 Half Day Road, Suite 500
Lincolnshire, IL 60069 USA
T: +1 847 634 6700
Toll-free +1 866 230 9494
F: +1 847 913 8766

Zebra Technologies Europe 
Limited
Dukes Meadow
Millboard Road
Bourne End
Buckinghamshire, SL8 5XF
United Kingdom

T: +44 (0) 1628 556000
F: +44 (0) 1628 556001

Zebra Technologies Asia Pacific 
Pte. Ltd.
120 Robinson Road
#06-01 Parakou Building
Singapore 068913

T: + 65 6858 0722
F:  +65 6885 0838

Technical Support
For questions on the 
operation of Zebra 
equipment and software, 
please call your distributor. 
For additional assistance, 
contact us.

Please have your model and 
serial numbers available.

T: +1 877 ASK ZEBRA (275 9327)
F: +1 847 913 2578

Hardware: ts1@zebra.com 
Software: ts3@zebra.com 

Kiosk printers:
T: +1 866 322 5202
E: kiosksupport@zebra.com

T: +44 (0) 1628 556039
F: +44 (0)  1628 556003

E:  Tseurope@zebra.com 

T: +65 6858 0722
F: +65 6885 0838

E: China: tschina@zebra.com
All other areas:
tsasiapacific@zebra.com

Repair Service 
Department
For back-to-base service 
and repair.

T: +1 877 ASK ZEBRA (275 9327)
F: +1 847 821 1797

E: repair@zebra.com 

To request a repair in the U.S.,
go to www.zebra.com/repair.  

T: +44 (0) 1772 693069
F: +44 (0) 1772 693046 

New requests: ukrma@zebra.com 
Status updates:
repairupdate@zebra.com 

T: +65 6858 0722
F: +65 6885 0838

E: China: tschina@zebra.com
All other areas:
tsasiapacific@zebra.com

Technical Training 
Department
For Zebra product training 
courses.

T: +1 847 793 6868
T: +1 847 793 6864
F: +1 847 913 2578

E: ttamerica@zebra.com 

T: +44 (0) 1628 556000
F: +44 (0) 1628 556001

E: Eurtraining@zebra.com 

T: + 65 6858 0722
F: +65 6885 0838

E: China: tschina@zebra.com
All other areas:
tsasiapacific@zebra.com

Inquiry Department
For product literature and 
distributor and dealer 
information.

T: +1 877 ASK ZEBRA (275 9327)

E: inquiry4@zebra.com 

T: +44 (0) 1628 556037
F: +44 (0) 1628 556005

E: mseurope@zebra.com 

E: China: 
GCmarketing@zebra.com
All other areas:
APACChannelmarketing@zebra.co
m

Customer Service 
Department (US)
Internal Sales 
Department (UK)
For printers, parts, media, 
and ribbon, please call your 
distributor or contact us.

T: +1 877 ASK ZEBRA (275 9327)

E: clientcare@zebra.com 

T: +44 (0) 1628 556032
F: +44 (0) 1628 556001

E: cseurope@zebra.com 

T: +65 6858 0722 
F: +65 6885 0836 

E: China: order-csr@zebra.com
All other areas:
csasiapacific@zebra.com 

Key: T: Telephone
F: Facsimile
E: E-mail
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Glossary of Terms
Auto translation

Bar code interpretation in human readable characters.

Darkness

The print-head temperature defines the print darkness. The higher is the temperature, the 
darker is the printout. (thermal printers only)

Descender bars

Longer first and last bar in the EAN 13 bar codes.

Quiet zone

The empty place before and after the bar code symbol. This is necessary for the bar code 
reader to properly read the bar code.

Security

The definition of the control check-digit with some bar code types.
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Numerics
12-hour

time format 144
24-hour

time format 144
2D-Pharmacode 118
32-bit Windows 8, 12
64-bit Windows 12
8-bit 111

A
A.Z 111
About 9, 36
Activate 26

Copy 26
Paste 26

Activate button 14
Activate ZebraDesigner Pro 14
Activating 14

ZebraDesigner Pro 14
Activation 9
AD951 145
ADC 145
Add 128

Fields 128
Add button 88, 100, 110
Addon 118
Administrator 12
AID 110

select 110
Align toolbar 55, 120
Aligning 120

Objects 120

All 128 Extended ASCII 111
All EBCDIC 112
All ISO 112
Alt 17, 25

holding 17
pressing 25

Alt + Backspace 18
Alt + Shift 18
AM/PM 144
AND 23
And/or 123
Anker 118
Application Identifier 103, 104, 105, 106, 107, 109, 

110
depending 103
long 107
selected 105

Application Identifiers 107
Area/object 17
Arrange Icons 35
ASCII 33, 123, 137
ASCII file 87, 99
Aspect Ratio 111
Auto 115
Auto-determined 131
Automatic Sizing 42, 48
Auto-translation 115
Available Date Formats 143
Aztec 118

B
Back 131

Database Wizard 131
Backspace 18, 25
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Backspace key 25
Bar

Define button 113
Bar Code 31, 140

selecting 31
Bar Code button 77
Bar Code group

two-dimensional 118
Bar Code Object 77

Defining 77
Bar Code Wizard 92
Bitmap 121

BMP 54
Bitmap Windows 75
BMP 121
Bookland 118
Border Size 112
Browse button 125, 129

use 125
Build Expression 90, 102

C
Calculating 108

Check Digit 108
Cancel button 113

clicking 113
Captions 33
Cascade 35
Category

Working Window 141
CC-A/B 118
CC-C 118
CD 12
CD-ROM 12
Change 72, 73

Dithering Type 73
Speed 72

Change Common Printer Settings 72
Change Dithering Options 73
Check 114
Check Digit 108

13th place 115
Calculating 108

Check Digit Tab 114
Checkbox 24
Choose Arial 51
Choose Delimited 137
Choose Fixed 137
Choosing 25, 81, 137

Data Type 137
Open 25
Undo 25

Choosing Data Type 137
Choosing Variable Bar Code 93
Choosing Variable Text 81
Clicking 19, 27, 46, 113, 124

Cancel button 113
Finish button 46
Next button 124
OK button 113
Open button 19
Paste-link 27

Close 19, 35, 131
Print dialog 135
Text File Wizard 130

Close All 35
Close All Software Applications 12
Close button 21, 134, 136
Codabar 118
Codablock F 118
CODE 128 118
Code 32 118
Code 39 118
Code 39 Full ASCII 118
Code 93 118
Code Type 93
Code Wizard 92, 93, 94, 95, 97, 98, 99, 100, 102, 

103
Code Wizard dialog 77
Code128 53
Code128 bar 53
Code-39 117
Codes 30, 31, 33
Comma 130

set 131
Comma Separated Values 137
Command window 134
Composite RSS symbologies 118
CompuServer Bitmap 121
Computers 123
Connect 129

Database 129
Contact Information 153
Contents 8, 36, 145

package 8
Contents Mask 145
Contents Provider 17
Control 137

Database Wizard 137
Control Panel 20
Copy 26

activate 26
Counter 95
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Create 27, 46
New Label 46

Create Database Connection 33
Create Date 61
Create Keyboard Entry Variable Fields 57
Create New 27
Create Serialized Data Variable Fields 59
CSV 137
Ctrl 17, 18, 24, 26, 118, 141

Holding 17, 18, 118
pressing 26

CTRL key 14, 17, 23, 26, 27, 28, 29, 40, 120
hold 24
holding 17
use 17

CUR 121
Customize button 14, 23, 26, 27, 28, 29, 40
Cut 26

D
D/M/YYYY 143
Darkness 72
Data 130

Format 130
Data Matrix 112
Data Type 137

Choosing 137
Data View 28
Database Field 128
Database File 125

Selecting 125
Database Menu 33
Database Wizard 124, 129, 131, 134, 137, 138, 139

back 131
control 137

Databases 87, 99, 123, 124, 129
Connect 129
Select 124

DataMatrix 118
DataMatrix Bar Code 111
Date 85
Date Field 85, 97
Date/time 57
DD 143
DD/MM/YY 143
DDD 143
DDDD 143
Define button 53, 92, 113

bar 113
Define Label 47
Define Setup Options 13

Defining 42, 44, 77, 78, 79, 108, 110
Bar Code Object 77
Ellipse Object 79
Inverse Object 79
Label Dimensions 44
Line Object 78
New Variable 108
Page Size 42
Picture Object 78
Prompt 110
Rectangle Object 78
Text Object 77

Del 26
Del key 27
Delete 27
Delete button 110
Delete Database 33
Delimited 130, 138

select 130
Delimiter 138

select 138
DEMO 14

use 14
DEMO dialog 14
Demo Mode 14
Depending 36, 103

AI 103
Windows 36

Descender 117, 155
Description 141

Working Window 141
Deselect 126

want 126
Design toolbar 30, 120

enable 120
Designing 9

Labels 9
Desired Fields 126

Selecting 126
Details 117
Details Tab 117
DIB 121
Display 64
Display Grid 29
Dithering 73

Open 73
Dithering Type 73

Change 73
Document1 19
Document2 19
Dont 46
Down 110
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DUN-14 118

E
EAN 114, 117, 118
EAN 13 bar 155
EAN bar 117
EAN.UCC 128 118
EAN.UCC 128 bar 104, 110

select 104, 110
structure 103

EAN.UCC 128 Bar Code 110
EAN.UCC 128 Wizard 104
EAN-13 118
EAN-13 bar 115
EAN-14 118
EAN-8 118
EAS

settings 71
ECC Type 111
Edit bar 113
Edit Bar Code dialog 53
Edit Bar Code dialog Box 113
Edit button 110
Editing 119

Objects 119
Electronic Article Surveillance 71
Ellipse 31, 32

selecting 32
Ellipse button 79
Ellipse Object 79

Defining 79
Ellipse tool 79

selecting 79
EMF 121, 148
Enable 113, 120, 142

Design toolbar 120
Variable 142

Enable/disable 114
Enhanced Windows Metafile 121
Enlarge/reduce 76
Enter 90, 102

Visual Basic 90, 102
Enter key 119
Enter Non-Changing Text 50
Enter product weight 64
Error Correction Codes 112
Exact Search 23
Existing 33, 123

ODBC 33
ODBC Data Sources 123

Exit 25

Export 20
Printer 20

Expression 141
Working Window 141

Expression Builder 90, 102
open 90, 102

F
F2 19
F4 25
FAQ 152
FAX 121
Field1 124
Field2 124
Fields 128, 138, 139

Adding 128
Formatting 139
Setting 138

File menu 19, 20, 21, 25, 35, 46, 73, 148
Find button 14, 23, 26, 27, 28, 29, 40
Finish button 44, 46, 47, 50, 53, 56, 57, 59, 61, 64, 

77, 109, 110, 119, 124, 130, 131, 142
clicking 46

Folder 9
Follow 13, 57, 77, 140

onscreen 13, 77
screenshots 57
Visual Basic 140

Font button 115
Font Downloader 149

use 149
Format ID 112
Formatting 130, 139

Data 130
Fields 139

Frequently Asked Questions 152
Full 128 ASCII 111, 112

G
G3F 121
G3N 121
General 113
General Tab 113
GIF 54, 121
Global Trade Item Number 105
GLOBALS.TDB 36
Glossary 155

Terms 155
Graphics 32, 54
GreyMap 121
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Grid 29, 55
Snap 29, 55

Group 13, 118
ZebraDesigner Pro 13

Grouping
objects 122

GS1-128 118
GTIN 105
Guidelines

Object Positioning 52

H
h 144
Halftoning 73
Hh 144
hh 144
Hold 17, 18, 24, 118

Alt 17
Ctrl 17, 18, 118
CTRL key 14, 17, 23, 26, 27, 28, 29, 40, 120
Shift 17, 18

Human 115
Human Readable 145
Human Readable Tab 115

I
ICB 121
ICO 121
Identifier Input Type 106
Identifiers 109
If.then.else 140
Include EAN 117
Incremented/decremented 110
InfoGlyph 118
Input 140

Visual Basic 140
Input Application 109
Ins 26
Insert Bar Codes 53
Insert button 141
Insert Object 27
Insert Pictures 54
Inserts 27

OLE 27
Install button 13
Install Printer Driver 46
Installation/demonstration 12
Installed 12, 13

ZebraDesigner 13
ZebraDesigner Pro 12

Intercharacter 117

Interface Reference 9
Inverse 31, 32

selecting 32
Inverse button 79
Inverse Object 79

Defining 79
ITF 14 118
ITF 16 118

J
J2K 121
Jane 124
January 143
JJJ 143
JJJWWYYYY 143
JP2 121
JPC 121
JPE 121
JPEG 54, 121
JPEG Bitmap 121
JPEG2000 121
JPEG2000 Code Stream 121
JPG 121

K
Keyboard 17, 82

Using 17
Keyboard Input 82, 94
Kix 118

L
L 112
Label 9, 20, 36, 44, 55, 128, 131, 134, 136, 148

Designing 9
Place Database Fields 131
Print 136, 148
Save 55
use 20
View 134

Label Dimensions 42, 44
Defining 44

Label Orientation 43
Selecting 43

Label Quantity 148
Label Setup 20
Label Setup Wizard 19, 36, 39, 46
Label Stock 41
Language 34
Language Help 141
Large Icons 33
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Leave 46, 48
Page Size 47
Wizard 46

LEFT 140
LEISURE.WMF 54
liability 2
Line 31, 32, 56, 78

selecting 32
Line Object 78

Defining 78
Linear RSS symbologies 118
Linked 28, 123
Linked Field 88, 100
Load 141
Long

Application Identifiers 107
LVR 36

M
Main Window 16
Manual 9
MaxiCode 118
MaxiCode 2D Code 112
MB 12

RAM 12
Menus Show Recently Used Commands First 33
Merging 142

Real Time Clock 142
Metafile Picture 26
MicroPDF 118
MicroQR 118
Microsoft 90, 102, 140

open 90, 102, 140
refer 140

Microsoft Access 33, 123
Microsoft Excel 33, 123
Microsoft Word 26, 123
Mirror horizontally/mirror 117
MM 143
mm

time format 144
MMM 143
MMMM 143
MMMM YYYY 143
More windows 35
Mouse Effectively 17
Mouse Wheel support 18
Moving 119

Objects 119
MSI 118

My Documents 19, 20
My Labels 19
MyField1 140
MyField2 140

N
Name 141

Working Window 141
New 46
New Date Field 61
New Keyboard Input 57, 64
New Label 19, 46

Create 46
New Time Field 61
New Variable 108

Defining 108
Next button 13, 39, 41, 42, 43, 46, 47, 64, 77, 110, 

124, 129, 130, 131, 134, 142
clicking 124

Non Blanks 24
Normal View 28
Notepad 123

O
Object

Positioning Guidelines 52
Object menu 31, 32
Objects 118, 119, 120, 121

Aligning 120
Editing 119
grouping 122
Moving 119
Resizing 120
Rotating 121
Selecting 118

ODBC 33
Existing 33

ODBC Data Sources 123
Existing 123

OK 9
OK button 53, 72, 73, 113, 134, 136

clicking 113
OLE 27

inserts 27
OLE DB 12

Support 12
Online Support 152
Onscreen 13, 21, 77

Follow 13, 77
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Open 19, 25, 72, 73, 90, 102, 140
choosing 25
Dithering 73
Expression Builder 90, 102
Microsoft 90, 102, 140
Options 72
Visual Basic 140

Open button 19, 54, 78
clicking 19

Open dialog 54, 78
Open ZebraDesigner Pro 46
Optimize 149

Printing Speed 149
Options 72

Open 72
OR 14, 23, 26, 27, 28, 29, 40
Overview 45, 57, 128

P
Package 8

Contents 8
Page Dimensions 47
Page Size 42, 47

Defining 42
Leave 48

Part>| 92
Paste 26, 27

activate 26
Paste Link 14, 26, 27, 28, 40
Paste Special 14, 26, 40
Paste-link 27

clicking 27
PBM 121
PC 9, 12, 85, 86
PCX 54, 121
PDF 417 111
PDF 417 2D Code 111
PDF-417 118
Pentium-based 12
PGM 121
Pharmacode 118
Picture 31, 78, 148

Previewing 148
selecting 31

Picture Object 78
Defining 78

PIX 121
Place Database Fields 131

Label 131
Plessy 118
PNG 121

Portable Network Graphics 121
Portable Pixmap 121
Postnest-62 118
Postnet-32 118
Postnet-37 118
Postnet-52 118
PPM 121
Prefix 91, 103

Setting 91
Press 25, 26, 118

Alt 25
Ctrl 26
Enter key 119
Shift 25, 26
Shift key 118

Preview 21, 85, 86, 97, 98, 110, 148
Pictures 148

Preview button 21, 134, 148
Previewing Labels 9
Previous button 124
Print 21, 72, 127, 136, 148

10 148
Label 136, 148

print
simulate 10 labels 148

Print / Print 134
Print bar 114
Print button 21, 136, 148
Print dialog 21, 135, 136, 148

return 135
Print dialog box 21
Print Preview 21
Printer 20, 46, 72

Export 20
Select 46

Printer Settings 20, 72, 73
Printing Speed 149

Optimize 149
Program Files/ZebraDesigner Pro/Bin/System 36
Programming 33
Project 36
Prompt 110

define 110
Properties button 39
PXM 121

Q
QR 118
Quantity 134
Quick Launch 13
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R
RAM 12

MB 12
Real Time Clock 86, 88, 142

merging 142
surrounding 142

Recent Windows 12
Recently Used Files 25
Record Selection 14, 23, 26, 27, 28, 29, 40
Record Selection dialog 23, 135
Rectangle 31, 32

selecting 32
Rectangle button 78
Rectangle Object 78

Defining 78
Rectangle tool 78

selecting 78
Redo 25
Refer 140

Microsoft 140
Related Topics button 57

Replace 141
Resizing 120

Objects 120
OLE 27

Result 26
Return 135

Print dialog 135
RFID 89, 101

tag locking 70
tag settings 70
tag support 69

RFID smart label 65
create 66

RFID-enabled 89, 101
RLE 121
Rotated 43, 121

Objects 121
Rounded Rectangle 32
RSS 118
RSS Expanded 118
RSS Expanded, UPC-A 118
RSS Limited 118
RSS14 118
RSS14 Stacked 118
RSS14 Stacked Omnidirectional 118
RSS14 Truncated 118
RTC 85, 86, 142
Run Installation 12

S
SAMPLE.TXT 129
Samples 54, 129, 140

Visual Basic 140
Save 20, 55, 72, 73, 141

Label 55
selecting 73

Save As button 14, 23, 26, 27, 28, 29, 40
SCH 139
Scheme File 139
Screen 80

Text Wizard 80
Screenshots 57

following 57
Select All 23
Select Data 134

Use Print Preview 134
Select New Counter 59
Select Printer 39
Select Record 21
Select Records button 134, 136
Select Stock window 47
Selecting 27, 30, 31, 32, 39, 43, 46, 73, 78, 79, 104, 

110, 114, 118, 124, 125, 126, 127, 128, 
130, 138, 142

AID 110
Application Identifier 104
Bar Code 31
Database 124
Database File 125
Delimited 130
Delimiter 138
Desired Fields 126
EAN.UCC 128 bar 104, 110
Ellipse 32
Ellipse tool 79
Inverse 32
Label Orientation 43
Label Stock 41
Line 32
Objects 118
Picture 31
Printer 46
Rectangle 32
Rectangle tool 78
Save 73
Select 31
Text 31
Time Field 142
Variable Quantity 128
Which Records 127

Selection/de-selection 24
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Set 91, 131, 134, 138
Comma 130
Fields 138
Prefix 91
Variable 134

Settings/All Users/Application Data/Zebra/
ZebraDesigner Pro 36

SETUP.EXE 9
Shift 17, 18, 24, 25, 26

Holding 17, 18
pressing 25, 26

Shift key 26, 118
press 118

Shortcuts 18
Show Objects 28
simulate

printing 148
Small Icons 33
Snap 29, 55

Grid 29, 55
Software Restrictions 9
Speed 72

Change 72
ss

time format 144
SSCC 118
Standard Search 141
Standard Toolbar 30, 46, 72, 73, 129, 134, 136, 148
Start > Programs 9
Start menu 13
Start ZebraDesigner Pro 14
START.EXE 12
Starting 83, 95

Value 83, 95
Step 104, 106, 107, 109
Stock Type 41
Stop button 21
Structure 103, 112

EAN.UCC 128 bar 103
Structured bar 112
Subfolders 36
Subfolders Database 36
Suffix 64, 91, 103
Suffix Options 64
Support 12, 152

OLE DB 12
supported Bar Codes 118
Supported Graphics Formats 121
Surrounding 142

Real Time Clock 142
Symbology 103
System folder 36

T
Tab 17
TARGA 121
Targa Bitmap 121
Technical Support 9
Terms 155

Glossary 155
Test 25
Test Print 25
Text 30, 31, 140

selecting 31
Text button 77, 142
Text File Wizard 130, 137, 138, 139

close 131
Text Object 77

Defining 77
Text Toolbar 30, 50
Text Wizard 80, 81, 82, 85, 86, 87, 88, 90, 91

Counter 83
Counter Continuation 84
screen 80

Text Wizard dialog 77, 142
TGA 121
TIF 121
TIFF 121
TIFF Bitmap 121
Tile 35
Time 86
Time Field 86, 98, 142

Select 142
time format

12-hour 144
24-hour 144
h 144
mm 144
ss 144

Time Formats
available 144

Time Variable Fields 61
Toolbars 17, 33
Toolbox 31, 32, 50, 53, 54, 55, 56, 57, 59, 61, 64, 

67, 75, 77, 78, 79, 118, 142
Truetype 89, 101
Type Enter 57
Type SAMPLE 50
Types 118
Typographical Conventions 9

U
Undo 25

choose 25
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Unselect 23
UPC 118
UPC bar 114, 117
UPC Case Code 118
UPC-A 118
UPC-E 118
Use 14, 17, 20, 102, 125, 142, 149

Browse button 125
Ctrl key 17
DEMO 14
Font Downloader 149
Label 20
Visual Basic 102

Use Alignment Tools 55
Use Drawing Tools 56
Use Prefix 64
Use Print Preview 134

Select Data 134
Use Space key 14, 23, 26, 27, 28, 29, 40
User Guide 9
Using 17

Keyboard 17
Using Contents Mask 145
Using Data 124
Using Database Wizard 124
Using Design Toolbar 76
Using Expression Editor 141
Using Label Setup Wizard 39
Using Printer Real Time Clock 142
Using Standard Toolbar 74
Using Text Toolbar 75
Using the Toolbox 75

V
Value 83, 95

Starting 83, 95
Variable Quantity 128

Selecting 128
Variable Wizard 58
Variables 124, 134, 142

Enable 142
set 134

VB 140
VB Script Help 90, 102, 140
VDA 121
View 134

Label 134
View menu 55, 120

Visual Basic 90, 102, 123, 140, 141
Enter 90, 102
follow 140
Input 140
open 140
samples 140
use 102

Visual Basic Expression 90, 102, 140
VST 121

W
Want 126

deselect 126
Welcome 8
Welcome Wizard 36
Wheel Mouse 17
Which Records 127

Selecting 127
Windows 13, 19, 20, 24, 26, 36, 61, 149

depending 36
Windows 2000 8, 12
Windows application 27
Windows Bitmap 121
Windows Cursor 121
Windows dialog 36
Windows Icon 121
Windows Metafile 121
Windows NT 12
Windows Server 2003 8, 12
Windows Server 2008 8, 12
Windows Vista 8, 12
Windows XP 8, 12
Wizard 39, 42, 44, 46, 92, 104, 107, 124, 127, 138, 

139
leave 46

Wizard dialog 110
WMF 54, 121, 148
Word 26
Word file 27
Workarounds 152
WW 143
WYSIWYG 89, 101

X
X-Expansion 113
XP 12

Y
YY 143
YYYY 143
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Z
Zebra Technologies Corporation 153
Zebra Web site 152
ZebraDesigner 8, 9, 12, 13, 14, 42, 46

install 13
ZebraDesigner CD 8
ZebraDesigner Edition 12
ZebraDesigner Pro 9, 12, 13, 14, 16, 33, 42, 54, 57, 

72, 123, 128, 129, 131, 134, 148
Activating 14
group 13
installing 12

ZebraDesigner Pro CD 12
ZebraDesigner Pro DEMO 14
ZebraDesigner Pro User Guide 9
ZebraDesigner window 30
Zoom 28, 29
Zoom dialog 29
Zoom In 18, 28
Zoom Out 18, 29
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